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1 Pages updated for Forest Pack 4.3

Page
Page
Page
Page
Page
Page
Page

: General

: Add Geometry
: Forest Tools

: Forest LOD

: Areas

: Display

: Camera

Forest Pack is a plugin for Autodesk 3ds max, and 3ds max design, designed to give a complete

solution for creation of vast surfaces of trees and plants.

Forest enables you to scatter millions of proxies, high-poly meshes or billboards, and using

custom geometry shaders, create scenes with virtually unlimited number of objects and polygons

Download Forest Pack Lite, the free version of the plugin and use it in your personal and

commercial projects.

If you are new to Forest, see the Getting Started guide for videos, tutorials and more help in your

first steps using the software.
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2 Getting Started

If you are new to Forest Pack and you're worried about where to start, you've come to the right
place! Here is a very simple guide for getting started with the plugin.

To be current of new versions and latest news about our products, please subscribe to forums.
You can also follow us on Twitter.

2.1 Release Notes

You can check the most recent changes for your version current version in the release notes.

2.2 Tutorials and Reference

For a fast introduction to the capabilities of the plugin, you can watch the Basic tutorial. It shows
how to use 3D high-poly trees with Mental Ray or VRay, in an architectural environment. It can be
completed with Forest Lite. Next, we suggest to continue with the Modern Barn tutorial.
Completing it, you will learn to use most of the software options, from areas splines area to
advanced materials. It uses VRay or Mental Ray renderer and includes five parts with 90 minutes
of video. Finally Autumn Parks will get you quickly acquainted with Forest Colour. You'll find
many more tips and and tricks videos in our tutorials section. They're regularly updated so check
regularly!

2.3 HQ Plants models

If you are purchased some of the HQ Plants libraries, see the following tutorial to see how to

integrate the models in the library browser. To complete it you will need to download the HQ
Catalog add-on from downloads section.

2.4 Lite & Pro

If you are using Forest Pack Lite, remember that it can be used freely for your personal or

commercial projects. Click here if you want to see the differences with Forest Pack Pro, and the
benefits of upgrading to it.

To complete your learning of the plugin, see the full list of tutorials, visit the Gallery or read the
Help Reference. You can also ask to our technical staff, and share your experience with other

users in the forum.
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Thank you and enjoy using Forest Pack !
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3 Installation and customisation

This guide describes the directory structure of Forest Pack and how to customize it. We will use a
default Forest Pro installation, in Forest Lite some files may be different.

3.1 Directory Structure

We define <forestdir> as the folder where you installed Forest Pack (C:\Program Files (x86)\ltoo
Software\Forest Pack Pro by default) , and<maxdir> is your main 3DS directory.

The setup program creates the folder structure shown below in <forestdir> :

The plugins and shaders for VRay and Mental Ray are copied here:

Folder Path
3DS plugin <maxdir>\plugins\ForestPackPro.dlo
Maxscripts <maxdir>\scripts\ForestPack\forest_utils.ms

<maxdir>\scripts\ForestPack\optmat.mse

VRay shaders <maxdir>\ForestVRay150sp3.dll, ForestVRay20.dll and ForestVRay30.dll

Note: some files may not exist depending of the Max and VRay versions

MR shader Max 2010 and before: <maxdir>\mentalray\shaders_autoload\shaders\
library FShader3.dll
Max 2011 and 2012: <maxdir>\mentalimages\shaders_autoload\mentalray\
shaders\FShader3.dll
Max 2013 and newer: <maxdir>\NVIDIA\shaders_autoload\mentalray\shaders
\FShader3.dll
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Folder Path
MR shader Max 2010 and before: <maxdir>\mentalray\shaders_autoload\include\
descriptor FShader3.mi

Max 2011 and 2012: <maxdir>\mentalimages\shaders_autoload\mentalray\
include\FShader3.mi

Max 2013 and newer: <maxdir>\NVIDIA\shaders_autoload\mentalray\include\
FShader3.mi

The following entries are created in the Windows Registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Forest Pack Pro

MainDir = C:\Program Files (x86)\ltoo Software\ <forestdir> is defined here
Forest Pack Pro

UselicServer =0 0 to use Stand-alone license, 1 for
Network license

LicservHost = <host or ip> License server hostname, undefined for
automatic search

LicservPort = 16720 Protocol port number, by default 16720
TexturePaths (key) Texture paths
LibraryDir (key) Library paths

All commercial Itoo Software products use also additional keys for the licensing management:

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses

LicenseDir = C:\ProgramDatal\ltoo SoftwarellLicenses Forest Pro license is stored here

HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Licenses\Products

Forest Pack =9 One entry for each Itoo Software
product
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In a Windows 64 bit version, these registry keys are duplicated in
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node

3.2 Unattended Installation

From Forest Pack 3.9.2 and above, the setup program supports unattended installations using
the following parameters:

® /? - See available parameters
® /s - enable silent installation

® /maxver=[max9-32, max9-64, max2008-32, max2008-64, max2009-32, max2009-64,
max2010-32, max2010-64, max2011-32, max2011-64, max2012-32, max2012-64, max2013-
32, max2013-64, max2014-64, max2015-64]

® /MAXDIR=<3dmax installation path>
® /LICMODE=[rendermode, network, stand-alone]
® /LICHOSTH[License server host]

® /LICPORT=<License server TCP port>

Example of a silent installation for Max 2013

ForestPackPro.exe /S /IMAXVER=max2013-64

3.3 Network Rendering

You can install Forest on your renderfarm computers using the setup program, or copying the
files manually. In Forest Pro select "Render slave node", in Forest Lite use default installing
options.

For a manual installation, these are the required files:

Type Files

Plugin and  As described in the plugin and shaders table
shaders
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Type Files

Distribution = from "C:\Program Files (x86)\ltoo Software\Forest Pack Pro\distmaps\images",

Maps copy them to any shared texture folder
Tree all textures from "C:\Program Files (x86)\ltoo Software\Forest Pack Pro\maps" and
textures your custom textures, when used

If you use Presets or other elements of the Library, they must be visible by the render nodes. Use
the Asset Tracker to locate the texture maps and XRefs used by the scene.

From version 4.0.2, Forest configures automatically in the render nodes the paths listed in the
registry at HKEY_LOCAL_MACHINE\SOFTWARE\Itoo Software\Forest Pack Pro\TexturePaths.
These are the paths included by default by the installer:

c:\program files (x86)\itoo software\forest pack pro\\distmaps\images

c:\program files (x86)\itoo software\forest pack pro\maps\HShadows

c:\program files (x86)\itoo software\forest pack pro\maps\Standard

c:\program files (x86)\itoo software\forest pack pro\maps\Classic

c:\program files (x86)\itoo software\forest pack pro\maps\presets

c:\program files (x86)\itoo software\forest pack pro\lib\free models\hgplants free\maps

All these files can be installed on network paths if you configure Max to use them (as shared
plugins, Mental Ray shaders and textures). For details, see: Autodesk 3ds Max Help ->
Customizing the User Interface - > Configure Paths.

3.4 Is it possible to modify the sub-objects of a Forest
object from MaxScript?

Yes, but only if the Forest object is in "Custom Edit" mode. there is an interface named "trees" for
using it provided by MaxScript. You can see all the functions included witd "showinterfaces($
forest01)". these are the some of them:#

Add a tree in position p (local coordinates), using width, height and geometry ID values
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<Forestobject>.trees.create p:<point3> width:<float> height:<float> geomid: <integer>

Sforest0l.trees.create p:[50,50,0] width:10 heigth:10 geomid:1

Delete the tree at position n in the array

<Forestobject>.trees.delete n:.<integer>

Sforest0l.trees.delete n:0

Modify the properties of the the tree at position n (width, height, geometry ID, random seed)

<Forestobject>.trees.edit n:<integer> width:<float> height.<float> geomid.<integer> seed:<
integer>

Sforest0l.trees.edit n:0 width:10 height:10 geomid:1 seed:123456

Returns the number of trees of the object

<Forestobject>.trees.count()<integer>

Sforest(0l.trees.count ()

Move the n-th tree to the position p

<Forestobject>.trees.move n:<integer> p:<point3>

S$forest0Ol.trees.move n:0 p:[50,50,0]

Set the rotation of the n-th tree (angle in degrees)
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<Forestobject>.trees.rotate n:<integer> angle:<float>

Sforest0l.trees.rotate n:0 angle:45
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4 Lite and Pro

Fock Lite

The trs scaterng ool oSS e eSE o mmeEa Buy Now

Currently two versions are available: Forest Pack Lite and Forest Pack Pro. Forest Pack Lite is
free for any project, personal or commercial. However, some features are disabled and only
available in Forest Pack Pro.

4.1 Forest Pack Lite

This version is free for personal and commercial use for an unlimited period of time. It is fully

functional with some limitations listed below. You can get it from the Download page.

4.2 Forest Pack Pro

Forest Pack Pro has advanced features for surfaces, tree placement and importing/exporting
tools. Also it includes a full library of planar trees and shrubs that you can edit it and add your

own trees and textures. Visit our Online Store for more information about prices and license
options.

Feature list

Rendering Lite Pro

Native shaders for Mental Ray

Native shaders for VRay

Billboards optimization

Random tint by item

Tint by element (as leaves on a tree)
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Rendering Lite Pro

Scattering Lite Pro

Unlimited types of plants by object

Up to three types of plants by object

Unlimited areas by object

Up to four areas by object

Scattering over uneven surfaces

Diversity / Clusters

Custom Edit mode, to edit items individually

Distribution of items along a path

Real-time camera clipping

Points-cloud viewport mode

Random transformation of position, rotation and scale

Full Animation support, including multiple random samples

Collision checking

Libraries Lite Pro

Library browser

Library editor

More than 100 library items, including billboards, 3D models and Presets
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Rendering Lite Pro
Utilities Lite Pro

Real time status window
User presets

Creation tools

Forest tools

Conversion to editable Mesh

Other Benefits Lite Pro

Prioritized technical support
Early access to beta versions

Frequently patches and releases

4.3 Software Requirements

® 3D Studio Max 9 to 2014 (32 & 64 bits) or 3D Studio Max Design (same versions).

® VRay native shader requires Max 9 with VRay 1.50 SP3 or greater.

Version 18



Forest Pack Documentation

5 General

5.1 Overview

The General rollout contains plugin-wide settings including tools to create parameter-only
presets (for presets that include geometry and other external objects, see the Forest Library
section) . In the event that a render reports "Some forest were not built correctly in the last render
" this rollout also contains useful information that can help you to determine the cause.

5.2 Procedures

To check for a newer version of Forest Pack:

® Click the (Search for updates) button.

To open the help files:

® Click the (Show Forest Pack Help) button.

To create variations of the current Forest object:

® Change the Random Seed number.

To save the current settings as a preset:

1. Set the Forest object's parameters.

2. Type a name for the Preset in the Presets List box.

3. Click E (Save current settings as a preset)

To save the current settings as default:

1. Set the Forest object's parameters.

2. Type default in the Presets List box.

3. Click E (Save current settings as a preset). Every new Forest object will now inherit these
settings.
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To save a preset to an external file:
1. Set the Forest object's parameters.

2. Click E (Export preset to external file).

3. Type a name for the new preset file and click Save

To load a preset from an external file:

1. Click E (Import preset from external file).

2. Select a .fpe file and click Open.

3. To add the preset to the drop down list for easy access at a later date, click E (Save
current settings as a preset).

To disable Pop Ups

® Click Disable Pop-ups. Only Critical messages will now be shown.

5.3 Interface

Icon 5ize 1.0m
Randaom

Seed

CPU Threads

123456

v Auto

Disable Pop-ups

$ 0‘ Help T_!_ Stats
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Presets list

The presets field alows you to select from a list of saved presets or enter a new name and store
the current settings as a new preset. Clicking a name from the list overwrites the current numeric
parameters and options with those saved in the preset. References to all external objects, for
example in the geometry list, surface list, and cameras rollout, remain unaffected. References to
materials are saved, but they must be in the scene or the current material library.

E Save current settings as a preset

Delete preset from list
E Import preset from external file
E Export preset to external file

If a preset is created with the name "default", its values will be used automatically for all new
Forest objects.

You can copy the presets to any other computer that has Forest installed by copying the file
named "forest_presets.ini", located in the user's folder: $LOCALAPPDATAS \ Autodesk\3dsMax\/

max versionNENU\en-US\plugcfg.

® For most uses this feature has been superseded by loading and saving presets via the
Forest Library, however it remains useful as a quick way of copying settings between
Forest objects and setting defaults values.

Icon Size

Defines the size of the Forest icon. This will display when the plugin cannot create objects
because not all the required parameters have yet been defined, or because of an error condition,

Random Seed

A numeric value used to initialize the random number generator. This number affects any
randomised properties of the Forest Pack plugin. For a given seed value, the Forest object will
always produce the same results.

Version 18



Forest Pack Documentation

CPU Threads

Defines the number of threads used by Forest to build the scattered geometry. The default value
(Auto) automatically detects the number of CPU cores. Usually is not recommended that you
modify this parameter.

Disable Pop Ups

When enabled all suggestions and warning messages are turned off except for critical errors (this
option is global and persistent).

Search for Updates

Checks the installed version of Forest Pack is up to date. If an update is available a dialog box
will open with version information and an option to Go to the Update Site.

Show Forest Pack Help

Opens Forest Pack's online help files in the user's default web browser.

Statistics Window

Opens a floating window showing statistics of the last selected Forest object, including the
number of trees created, build time, maximum density of trees in the area, etc.

If Forest cannot create trees because of an error condition (indicated by displaying an orange "F"
icon in the viewport instead of the trees), this window can be used to get additional information
about the cause of the problem.

"

Forest Stats @

Mame (first instance): Forestl01

o4.0M items in area

N/A

oo high, Increase the
bution Map parameters
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Forest stats showing a "density too high" error
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6 Add Geometry

6.1 Overview

Forest Pro enables you to choose from an unlimited number of different objects to scatter, these
are managed from the Geometry List. ltems can be loaded from the library or picked directly from
the scene, any valid geometry object can be used, the table below outlines the types supported
by each renderer. There is no need to convert meshes to Proxies, Forest pack use native
geometric shaders to automatically creates instances on the fly for compatible renderers.

Renderer Supported Objects

Scanline Meshes (or any object that can be converted to mesh).

Mental Ray Meshes, MR Proxies and RPC objects.

V-Ray Meshes, V-Ray Proxies
Maxwell Meshes, Maxwell Proxies
Octane Meshes

Thea Meshes

Arion Meshes

Corona Meshes

6.2 Procedures

To create a new Forest Object based on a spline area or surface:

1. Go to Create > Geometry > ltoo Software and click Forest Pro

2. Select a mesh, billboard, or preset by clicking the Select button and picking from the
Forest Library. If the object you wish to use is not in the library, skip this step and a simple
plane object will be used. This can be adjusted later to use your own custom objects in the
Geometry rollout.
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3. Ensure the mode is set to Generate.

4. Click a spline area or surface in the viewport. Go to the Modify panel to access parameters
for Add Geometry, Areas, Distribution, Camera, Transforms, Animation and more.

To create a new Forest object using Custom Edit:

1. Go to Create > Geometry > Itoo Software and select Forest Pro.
Change the mode to Custom Edit.

Click anywhere in the scene to place trees.

> @D

When you are finished, right click to exit create mode. Further parameters such as Add
Geometry, Surface, Camera, Transforms, Animation and more can now be adjusted in the
modify panel, to further add or modify objects please see the Tree Editor reference.

To add a new object to the Geometry list from the library:
1. Create a new Forest Object as described above.

2. Open the Geometry rollout and click (Add New Item).

3. The properties section determines the type of geometry to create, to load an object from

the library, Click on .

4. The library browser will open, use the directory navigator on the left of the interface to
select an library, then pick the desired object from the items view.
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5. To use the selected object, either double click, right click and select Use ltem(s), or click

Import Selected.

To add a new Billboard object to the Geometry List:

1. Open the Geometry rollout and click on ﬂ (Add New Item).

2. From the Properties section select Template and set the type of billboard geometry from

the drop down list.

* Template -

One Flane

Four Planes

Curved Plane

Low Animated Plane

Medium Animated Plane

High Animated Plane
15imple 30 Tree

3. Set the Width and Height, To constrain proportions click 4 (Lock Aspect Ratio) found to

the right of the spinners.
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4. Apply a material to the planes by dragging or copy and pasting an instance to the
Properties > Material pick button. Ensure you assign the material to this button, not the
Forest object itself. Forest automatically manages a multi-sub object material based on the
materials assigned in the Geometry List rollout. If you do accidentally overwrite this,

Reassign Material

recover it by clicking . See the reference section below for more

information.

5. If necessary, move the pivot position used for rotation by adjusting the Centre
Displacement value. This is measured as a percentage of the overall billboard width.

To add a new geometry object to the Geometry List:

1. Open the Geometry rollout and click on (Add New Item).
2. From the Properties section, change the geometry type from template to Custom Object.

3. Click on the Custom Object picker button (marked "none") and select an object to be
scattered from the scene. Any materials applied to the object will be retained.

To add a group to the Geometry List:

Adding groups must be done using the name selector. Max does not support picking groups
from the scene. A group can be added in two ways.

Either:

1. Open the Geometry rollout and click (Add New ltem).
2. From the Properties section, change the geometry type from template to Custom Object.

3. Click on the Custom Object picker button (marked "none") . Groups cannot be selected by
clicking on them in the scene, instead open the Select From Scene dialog by pressing H
on the keyboard. Select a group from the list and either double click or press the Use
button.

Or:

1. Click (Add Multiple Custom Objects) from below the geometry list, this will
automatically open the pick from scene geometry list.

2. Select either a single or multiple groups from the list and click .

@ Groups (FP4 and above only)
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This mode is useful to scatter groups of objects, preserving their composition, for
example clumps of plants like flowers or grass. It works well when used in combination
with Distribution > Diversity > Clusters.

Once scattered elements of a group are handled as individual items, both for the
boundary checking and surface placement. This also has a noticeable impact on the
number of items generated, so care should be exercised when scattering groups that
contain many objects.

Do not use groups for objects that must be handled as a unique object (for example a
tree and its leaves). In this case, attach all the individual parts into single mesh.

To add a blank object to the Geometry List (to create gaps):

To create blank spaces or gaps in a scatter, null objects can be added to the geometry list. This
will be taken into consideration as part of the distribution but no geometry will be generated.

1. Open the Geometry rollout and click (Add New Item).
2. From the Properties section, change the geometry type from template to Disabled.

3. Change the probability of a null object being selected using the Properties > Probability
parameter.

To add multiple objects to the Geometry List:

1. Open the Geometry rollout and click (Add Multiple Custom Objects).

2. Select the objects to use from the list. To select multiple object from the list either select
individually while holding down control, or select a range by clicking the first object then
hold down shift and click the last object.

3. Click to use the selected objects.

To delete and object from the Geometry List:

1. Select the item from the the Geometry List.

2. Press n (Delete ltem).

To Copy and Paste objects:

1. Select the source item from the geometry list.

2. Click E (Copy item values).
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3. Select the target item, or create a new one by clicking ﬂ (Add New Item).

4. Click E (Paste item values).

To change the order of objects:

When using forest in custom edit mode items can be created in a sequence instead of randomly
selected from the geometry list. When using this feature it is helpful to be able to rearrange the
order of the objects in the Geometry list.

® To move an object up the Geometry list, select it and click on | (Move up).

® To move an object down the Geometry list, select it and click on the | (Move down).

To manually set the height and width of a billboard or custom object:

1. Select an item from the Geometry List.

2. If the item is a Custom Object, turn off Use Objects Dimensions.

w

. Use the Width and Height parameters to set a new size for the object.

Height 0.029m

E-N

. By default the Width and Height are constrained maintain proportions, uncheck ks (Keep
Aspect Ratio) to change the width and height independently.

To manually set the height and width of all objects:

1. Turn on Global Size>Apply.

2. Adjust the Global Size > Width and Height parameters, all items in the geometry list will
use the new values.

Global Size

App |"|-' v

Width 0.1559m =

Height 0.57m

To adjust the size of all objects, retaining the original proportions:

® Adjust the Global Scale value, measured as a percentage of either the items original size,
or as set in the Properties > Width and Height parameter. The default scale value is 100%.

Version 18



Forest Pack Documentation

To assign a color ID:

1. Select an object from the Items List.
Click on the Color ID color swatch to open the 3DS Max color picker.

Select a new color and click OK.

> @ D

Turn on Display > Viewport > Use Color ID to display the color in the viewport, or see the
Distribution Map reference to see how to use Color IDs in conjunction with RGB maps to
place items.

To assign a material to an object:

® To apply a material to an object in the Items List, select the item from the list then drag a
material from the Slate or Compact Editor to the Properties > Material Name slot.
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To rebuild materials if accidentally overwritten:
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Halme [0 [4] )

Cane 01

Width

o

Height

gy ol
Center Displ,

Caollision Radius 100

A

Jrobability 100:0 5 %N R

® Since any object in Max can only have one material applied, Forest Pack Pro automatically

creates a Multi/Sub object material based on the materials assigned to each individual

item in the Geometry List. If accidentally overwritten or lost, simply press
to recreate the Forest auto-material.

To adjust the probability of an object being used:

Either
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® To manually adjust the chance of an item from the geometry list being selected change
the Properties>Probability percentage the value will be displayed next to the name in the
items list. The percentages are normalised automatically behind the scenes, however, if
you wish to display these values, click 1 | (Normalise).

or

® To create randomised values for all objects in the Geometry List, click bl (Randomize).
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6.3 Interface
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Geometry

_fp_dry4... 0
_fp_cutar...
_fp_dry4...

= . B R
Properties

Library
MName Color ID
_fp_dryHeaf_maple_02

Disabled

Template

Width
Height
Z Offset 0.029m
Center Displ. 50
Collision Radius 100
# Custom Object Clear
ary_UOMCEZ

v Use Object Dimensions

robability 0.5 * %N R

Material Clear

-dry-fc-maple andard )

v Get Size from Library

Global Size
B pp | v

Width 0.02m =

Height 0.03m =

A &

Global Scale 1000 & %6
v Consolidate Materials

Reassign Material

Geometry Interface
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Geometry List

Description of the geometry list

3
. Add object to the Geometry List

Remove selected object(s) from the Geometry List

P

Add multiple objects to the Geometry List

Copy selected object(s)

Paste objects(s)

Move selected object(s) up/down

Properties group

Library

Opens the Forest Library allowing you to import individual 3d meshes, billboards and complete
presets.

Get Size from Library

When on an item will inherit Width, Height, Z Offset, and Center Displacement values from the
library. When unselected only the material is imported.

In Forest Pack 4.3 this option is removed and enable by default

Color ID

Used to define the color of items in the viewport when Display > Viewport > Use Color ID is active
. This parameter can also be used in conjunction with Distribution Map > Diversity > Match Color

ID on Map. This mode allows you to place items according to pixel information most closely
matching the Color ID on a bitmap or procedural map.
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Name

Shows the name of the selected item. The name updates automatically to match the source
geometry but can also be edited manually.

Disable

Disables geometry for the selected item. This is not the same as deleting the item, it will still be
taken into consideration as part of the scatter algorithm, but will not render leaving a space.

Template

Use a predefined geometry template from the drop-down list. Used for billboards, for 3d
geometry use the Forest Library

It is possible to create your own templates by editing an index.dat text file and using standard
Max scenes for the meshes, see Installation and customisation for details.

Custom Object

Use a custom mesh. Click this button to select the source object from the scene. when an object
is selected the button will display the source name, otherwise it will return None. To delete
references to the source, click Clear.

Use Object Dimensions

When on, objects use the size of the source object. When off the size is defined by the Width and
Height values.

From Forest Pack 4.3 this option is removed. To resize custom objects use the Scale
value.

Scale Forest 4.3 Only

Set the scale of a custom object. Measured as a percentage of its original size.

Width

Set the width of Billboards. (use & to constrain proportions)

Height

Set the height of Billboards. (use &« to constrain proportions)
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Z Offset

Sets an offset value on the Z Axis, measured in scene units.

Center Displace

Adjust the lateral pivot position. Useful when using billboards which can rotate on the Z axis to
keep them facing toward the camera. Use this value to adjust the rotation point for textures that
require an offset pivot.

50%

— 0%

A

R

Collision Radius

Defines the collisions radius for the selected item. This value is multiplied by the global radius
parameter found in the Distribution Map rollout, to compute the distance between objects to
detect a collision.

Probability

Defines a percentage probability that the item will be selected in the random distribution. If the
sum of all the probabilities in the Geometry List exceeds 100%, the values are normalized
internally by the distribution algorithm. You can also use the [ t0 normalize the list manually and
B 0 randomize the values.

Material

Used to assign a material to the selected item.

(0 Forest Pack Auto-Material
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Forest needs to build a single multi-sub object material combining all the materials
applied to the items in the Geometry List. Because creating this material and correctly
assigning the material IDs manually would be a complex and time consuming procedure
, Forest performs this action automatically.

Subsequently applying materials to items is very different compared with the normal
workflow in 3DS Max. The material is NOT applied directly to the object using the
Material Editor, but instead selected as a parameter in the Geometry rollout, using the "
Material" pick button.

For Custom Objects, if material is not specified, Forest uses the material assigned to the
source object.

If you accidentally assign another material to a Forest object, use the "Reassign Material
" button to recover the auto-material.

Global Size group

In Forest Pack 4.3 this option is removed although these parameters can still be
accessed using maxscript using ("globsize", "width", "height”)

Apply
When on, all items take the Height and Width defined in the Global Size group settings. When off
ltems use their individual height and width settings

Width

Defines the global width value.

Height
Defines the global height value.

Global Scale

Applies a global scale factor to all items in the Geometry List.
Consolidate Materials

Is possible to disable the automaterial feature and assign the materials manually, although is not
recommended. For this, uncheck the "Consolidate Materials" parameter in the Geometry rollout.
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7/ Forest LOD

7.1 Overview

Forest LOD allows you to switch geometry objects based on their distance from the camera or
their size in the render view. The most common use for this feature is to create Level of Detail
models so that less complex models and materials can be used further from the camera to help
speed up renders.

Using LOD models with Forest Pack requires a slightly different workflow from using standard
geometry objects.

1. Instead of a single model for each object, LOD models require 2 or more models. Each of
these optionally can have unique materials.

2. Models are added to a Forest LOD object. From here you can configure the trigger
distance or size to switch between models, assign materials and blur the transition
between LOD levels.

3. Finally the Forest LOD object is scattered by adding it to the Geometry List inside a Forest
Pack object. From here it is also possible to override the distances used to calculate the
trigger points directly from the Camera Rollout.

[F. FERSLE A | [F, JTERE L L= A SR 1)
B Rl o

®-F
caa-f—F

7.2 Procedures

To create LODs based on distance from the camera

1. Go to Create > Itoo Software > Forest LOD and click and drag to create a new Forest LOD
object in the viewport.
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2. Add the objects to the Forest LOD object. To add a single object click on ﬂ , select
Custom Object, Click and pick an item from the scene. To add

multiple objects click and pick 1 or more items from the Object Picker.

3. Add Visibility > Max Distance values for each LOD level. The lower the value the closer to
the camera, so the more complex models should have the smaller values. See below for a

Mormalize Values

more detailed explanation. Alternatively you can click to automatically
create values based on the object's order in the LOD list.
Visibility

Max Distance || 50.0

F o .
= b
Mim Screen Size

Maormalize Value

4. Enter a Maximum Distance value. This defines the distance range over which the LOD
effect is calculated.

Mode

Max ance | 484.031r

=
=
Variation | 80.0 =

¥ Update on Viewport

Icon Size 7.839m  »

5. Add Variation if necessary to blur the transition between LOD levels.

£
6. Select or create a new Forest Pack object. Go to the Geometry Rollout, click on . and
select the Forest LOD object from the scene. There is no limit on the number of LOD

objects that can be used.
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7. If you want to override the maximum distance settings, go to the Camera Rollout and

increase the Max Distance value. Any value greater than O will override the settings used
in the Forest LOD object.

LOD (Level of Detail) _
on

rride
stance S0000m >

Use Environment Range

IJse Look-At Target

To create LODs based on screen size

1. Go to Create > Itoo Software > Forest LOD and click and drag to create a new Forest LOD
object in the viewport.

£
2. Add the objects to the Forest LOD object. To add a single object click on . , select
Custom Object , Click and pick an item from the scene. To add

multiple objects click and pick 1 or more items from the Object Picker.

3. Change the mode to Min Screen Size.

4. Add Visibility > Max Min Screen Size values for each LOD level. The higher the value the
closer to the camera, so the more complex models should have the larger values. See

Mormalize Values

below for a more detailed explanation. Alternatively you can click
automatically create values based on the object's order in the LOD list.
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Visibility

Max Distance

Min Screen Size

Mormalize Va

-
-
-
-

6. Select or create a new Forest Pack object. Go to the Geometry Rollout, click on ﬂ and

select the Forest LOD object from the scene. There is no limit on the number of LOD
objects that can be used.

To assign materials to LOD levels

1. Click on an object from the LOD List.

Field maple 25.0
Field maple 12.5
Field maple002 0.0

2. Drag a material from the Material Editor to the Material slot in the Properties group.
Simpler materials would normally be used furthest from the camera.
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Properties

¥ Material Editor - forest_automat 7B0F2D30 | — | = |[ﬁ]

Modes Material Mawvigation Options Utilities

Template

Vidth -
M
.
-
* Custom Object Clear
Field maple

Scale 100.0

rest_automat FEOFZD30 BB MultifSub-Object

3. Repeat for each object in the LOD List. Alternatively if you have a unique object for each
LOD level, you can apply materials directly to the source geometry.

To set Maximum Distance from a camera's Environment Range

1. In the Forest Pack object, go to the Camera rollout and turn on Use Environment Range

ID (Level of Detail) _
Un oW

300.0m 3
¥ Llze Environment Range

IJse Look-At Target

2. Select the camera and you can now use the Environment Ranges values to define the
Maximum Distance used to calculate the LOD levels.
Environment Ranges

¥ Show

Mear Range: 0.0m

To use a Custom Look-At Target

1. In the Forest Pack object, go to the Camera rollout and turn on Use Look-At Target.
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LOD (Level of Detail)

On w

2. Assign a Look-At Target from the Look-At group
Look-At

— On & Clear

MNone

3. Adjust the Max Distance. this will now be calculated radially from the Look At object.

7.3 Interface

LOD List

Use this list to add LOD levels for the current object. Each item on this list represents a single
LOD level. The number next to the name shows the percentage of either the distance from the
camera or the screen size at which this level becomes active.

To add geometry use the following buttons:

ﬂ Add object to the LOD List

n Remove selected object(s) from the LOD List

l

Add multiple objects to the LOD List

o

Copy selected object(s)

Paste objects(s)

Move selected object(s) up/down
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Properties

Disabled

Disables geometry for the selected item. This is not the same as deleting the item, it will still be
taken into consideration as part of the scatter algorithm, but will not render, leaving a space.

Template

Use a predefined geometry template from the drop-down list. Used for billboards.

Custom Object

Use a custom mesh. Click this button to select the source object from the scene. when an object
is selected the button will display the source name, otherwise it will return None. To remove
references to the source, click Clear.

Scale

Allows you to proportionately scale the geometry as a percentage of its original size.

Z Offset

Sets an offset value on the Z Axis, measured in scene units.

Center Displace

Adjust the lateral pivot position. Useful when using billboards which can rotate on the Z axis to
keep them facing toward the camera. Use this value to adjust the rotation point for textures that
require an offset pivot.

50%

— 90% >

A
L
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Material

Used to assign a material to the selected item. Each LOD level can use a different material

Visibility

The visibility group is used to control the point at which the LOD object switches between levels.

Max Distance

Used to set the trigger distance for each LOD level. Measured as a percentage of the Maximum
Distance value. An object is used when it exceeds this distance. If more than one LOD is eligible,
the one nearest the current distance value is used.

Min Screen Size

Used to set the trigger size for each LOD level. Measured as a percentage of screen size as
viewed from the active camera. An object is used when its size exceeds this value.

Normalize Values

Click this to automatically assign values to Max Distance or Min Screen Size for all LOD levels.
This function used the order of the objects in the LOD list to automatically calculate evenly
distributed values.

Mode
There are two modes:

® Maximum Distance. This is the default mode and uses a distance measured in scene
units radially from the active camera, or optionally a manually assigned custom look-at
target. An LOD level is triggered when its distance from the camera exceeds the
percentage specified by the Visibility > Max Distance value. In the illustration below LOD
1is set to 0% so displays immediately. LOD 2 is set to 33% and so becomes active and
replaces LOD 1 when an object's distance from the camera is a third of the maximum
distance. Finally all objects displayed further than 66% of the maximum distance from the
camera are replaced with LOD 3.

- &

Mazirwrn Cizlarge

) it o O

LETD T - P LCIR 3 - E33% LN 7 - fhts
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® Minimum screen size: This mode use the scatter object's size in the camera view to
switch between LOD levels. This is measured by comparing the diagonal length of the
bounding box to the diagonal length of the screen. In the illustration below LOD level 1is
set to appear only if the tree's diagonal length is greater than 25% of the screen's
diagonal. LOD 2 appears if the diagonal is below 25% but above 12.5%, and finally LOD 3
will appear when it's diagonal length is below 12.5% to infinity.

"‘FCa mera View )

LOD 1 -25% LOD2-12.5% LOD2-0%

Variation

Use this to add randomness to the Maximum distance or screen size settings creating a blurred
boundary between LOD levels. This helps to disguise the transition from one LOD level to
another and reduces obvious popping when rendering animations.

Variation = 0% o : Variation = 80%

Update on Viewport

When On, LOD effects will be visible in the viewport. When off LOD effects are only visible at
render time.

Icon Size
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Used to set the size of the Forest LOD icon.
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8 Areas

8.1 Overview

The areas rollout is used to define boundaries within which items from the Geometry list are
scattered. There are 5 types of areas that can be used in combination in a single Forest object:

® Splines.
® Objects
® Forests
® Paint.

® Surfaces.

Depending on the type, an area can be set to either Include or Exclude scatter items. Include is
an additive mode that creates items within the region, Exclude is subtractive, removing items
from the region. The table below illustrates the modes available for each area type.

Area Type Include Exclude

Spline

Object o
Forest o
Paint o
Surface

Surfaces allow you to scatter items on uneven surfaces, it is possible to toggle surface on and off
from the areas rollout but adding new surface areas and editing the parameters is handled in a
the Surfaces rollout.
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8.2 Procedures

To create a new Forest object based on a spline

1. Open the Create panel and select iToo Software from the object subcategory list.

Itoo Software
FuturArch Primitives

Helper

2. Click BEESSEEM and then click any spline in the viewport.

3. Open the Modify panel and make any necessary adjustment to the spline's settings from
the Area rollout.

To create a new Forest object based on a surface

1. Open the Create panel select iToo Software from the object subcategory list.

2. Click IS and then click a surface in the viewport.

3. Open the Modify panel and make any necessary adjustment to the settings from Surface
rollout.

To add a new closed spline area

1. Open the Areas rollout.

2. Click found below the Areas List.
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3. Pick a closed spline from the scene.

To add a new open spline area
1. Open the Areas rollout.

2. Click found below the Areas List.
3. Pick an open spline from the scene.

4. Adjust the Thickness value to define the width to scatter objects either side of the spline.
To add a new paint area

® To use a paint area you must also have a Surface area set to XY mode but this should
be switched off in the Areas list to restrict the scatter to only the painted regions.

1. Open the Areas rollout.

2. Click B3 found below the Areas List.

3. Click to open the Painter Settings.

4. Set the Min and Max brush size, if you are using a tablet turn on Enable Pressure

Sensitivity to use pen pressure to control the brush size.
' Painter Options E [=] @

Brush Properties
Strength: 0.0 0.0m
Strength: 1.0

Draw Trace

Mormal Scale: 10,0

Marker

Pressure Options

v Enable Pressure Sensitivity

Pressure Affects m

¥ E ] S &

Additive bW R T Misc
Mirrar Tree Depth: © =

viror [ Offset: Update On Mouse Up

Lag Rate: 0 5
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5. Click H and paint on the surface in the viewport.

6. Click and paint on the surface in the viewport to erase paint areas.

To convert a paint area to splines

1. Click

2. Modify the spline using 3DS Max's standard spline modelling tools.

8. If necessary, click m to restore the spline to a paint area (This can be done
with any spline object).

To exclude scattered items using splines

® In order to work correctly, exclude areas need to be above an include area in the Areas

List. To change the order order of areas use . . .

& New paint  Exclud

1. Open the Areas rollout.

2. Click found below the Areas List.

3. Pick a spline from the scene, if it is an open spline enter a Thickness value.
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Click Exclude.
Properties
Mame

Mew paint

Indude | * Exdude

To exclude scattered items using an object

1.

2.

Open the Areas rollout.

Click found below the Areas List.

Pick any geometry object from the scene. Where the object overlaps an include area the
scatter items will be removed.

To improve accuracy for large scenes increase the Resolution value (default is 512px).

To Increase or decrease the distance between scattered items and the object, adjust the
Scale value.

Srwke — TIHI% S pthe = AEHIM,

You can also use groups but this is recommended only when the objects are close
together. If you need to use multiple objects that are a large distance apart, assign each
one as a separate area.

To exclude scattered items using another Forest object

1.

2.
3.
4.
5.

Open the Areas rollout.

Click found below the Areas List.
Select a Forest object from the scene.
Adjust the Scale value if necessary to change the exclusion size around each tree.

Change Falloff > Exclude values for Density and scale (see below).

To create a separate region around the base of each tree.

1.
2.

Clone the Forest Object use in the last steps

Select the the Forest area from the list and click on Invert Curve.
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Adjust falloff, Add Geometry items and Distribution Map as required.

To add scale and density falloff along a boundary

Using falloff controls it is possible to affect the density and scale of objects near an area's
boundary.

1.
2.

Click Falloff > Density and Falloff > Scale.

Enter Include Range values to define the distance affected measured from an include
area's boundary.

Enter Exclude Range values to define the distance affected measured from an exclude
area's boundary.

The default falloff setting is linear, to change the falloff curve click Ikiumi

The falloff graphs have the range on the X Axis (from 100% to O %) and the Scale or Density
percentage on the Y Axis (from 0% to 100%).

] Area Density Falloff = Eo T

Drag to move, Ctrl-dick or drag regio 1.0 . ﬂ |:| [ ] : '_-' I-

To add scatter items around the perimeter of an exclude object

1. Add a Spline, Paint or Surface include area.

2. Add an Exclude area above the include area in the Areas list.

3. Turn on Falloff > Density and/or Falloff > Scale and enter an Exclude Range value.
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4. Click Invert Curve. This will reverse the effect of the falloff curve generating items only
around the perimeter of the exclude object.

To override the geometry used in an individual area

1. Select the Area to parameterise from the Areas List.
2. Click Plants > Select Models.

3. Click ﬂ and tick the models to use from the Select Models menu. Click OK.
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To limit the scatter using material IDs
1. For this feature to work, a Surface must be assigned in the Surface rollout and Forest must
be set to X/Y Mode.

2. In the Mat. ID list box, enter the Material ID numbers of the faces you wish to use to scatter
objects

3. To add multiple IDs simply add a list, ensuring there is a space between each value.

= Surface

Mat.ID 1332

To override the distribution map used in an individual area

1. Adjust the scale of the distribution map by adjusting Override Dist. Map > Scale.

2. Adjust the density of the distribution map by adjusting Override Dist. Map > Threshold.

3. Apply a new distribution map to the selected area by dragging a map to the Distribution
Map Slot.

— Override Dist.Map =

Mone
Scale Threshold

M M & AM M .
100.0 3 =4 100.0 5 =%

To prevent scattered items from "leaking" outside an area perimeter

® For V-Ray users, set Boundary Check mode to Edge.
Boundary Chedking

Paint Size  ® Edge

® For all other renderers, set Boundary Check mode to Size. To create large areas with well
defined boundaries, please refer to the Grass Edges tutorial.

— Bounda
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8.3 Interface

¢ Cylinderno2

I T4 Cylindero1
| E Surface Area

Areas List

The areas list details all the items being used to define the scatter region. The order is important,
areas are processed from the bottom of the list upwards, an exclude area will only affect areas
that are below it in the geometry list.

@ ® The areas are not available when working on Custom Edit mode or using UV_
Surfaces.

® |tis important not to overlap multiple Include areas. Overlapping areas duplicates
geometry and the issue is not always obvious in the viewports, but you may get
strange results in the render because of the coplanar faces.

Icon Name Description
Add spline area Adds an include/exclude area defined by a spline object.
Add object area Adds an exclude area defined by a geometry object.

Add forest area Adds an exclude area defined by a Forest Pack object.

Add paint area Adds an include/exclude area by painting a spline using the mouse
or tablet

Delete selected Removes the selected area.
area
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Icon Name Description
Add multiple Adds multiple areas from a list.
areas

Move up Move the selected area up.

Move down Move the selected area down

Selecting an area from the list will change the available options in the Properties group. Some
properties are common to all types of areas, while other are unique:

Circle0d1

* Indude Exdude

Spline

Circle001

Thickn
(open sp

Convert to Paint

Spline Area Properties

On

When active turns the current area on. If unselected the area will be ignored when calculating the
scatter regions.

Name

The name of the area. Default behaviour is to inherit the name of the source object but it can also
be edited manually.

Include

When active the area creates items within the region defined by the spline.
Exclude

When active the area removes items within the region defined by the spline. Only items
generated by areas below it in the Areas List will be affected.
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Spline

Displays the name of the selected spline. Click this to pick a new spline from the scene.

Thickness

Used with open splines to define the width of the path in which items are scattered.

Convert to Paint

Converts the Spline area to a Paint area.
Properties
Mame

Box003

Object

Box003

Top Limit |10.0cm 5

ution 512

Scale  100.0

Object Area Properties

Object areas allow you to use any geometry to exclude scattered objects. Object areas are
optimised for high polygon models and work by generating a black and white bitmap map by
projecting the geometry onto the surface along the world Z axis.

Object

Displays the name of the assigned objects. Click this to pick a new object from the scene.

Top Limit

Defines a height above which the object's geometry is ignored when calculating the exclusion
map .This feature is typically used for objects that are wider at the top than at the bottom.

Mo Limit Top Limit

444
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Resolution

Defines the size of the bitmap. Higher numbers result in greater accuracy typically required when
using large models. Default value is 512px.

Scale

Scales the exclusion effect. Values of less that 100% will move scattered items closed to the
object, values greater that 100% will push scattered items away from the object.

Properties

MName

Forestl02

#* Exdude
Forest
Forestl0?

shape

Resolution 1024

-
-
-
-

Scale 100.0

Forest Area Properties

Forest objects work in a similar way to Object areas allowing the use of a Forest object to create
an exclude area.

Forest

Displays the name of the assigned Forest object. Click this to pick a new forest from the scene.

Shape

Select from Sphere or Mesh to define the geometry used to create the exclusion effect. Sphere
use a virtual bounding sphere that is much faster though less accurate. The size of the sphere
can be adjusted using the Scale value of the area or by changing the Collision Radius parameter
for the ltems found in the Geometry Rollout.

Mesh mode uses the full geometry to calculate the exclusion effect. The approach is more
accurate but can be slower when using dense geometry.

Resolution

Defines the size of the bitmap. Higher numbers result in greater accuracy typically required when
using large models. Default value is 512px.
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Scale

Scales the exclusion effect. Values of less that 100% will move scattered items closed to the
object, values greater that 100% will push scattered items away from the object.

Properties
Mame
MNew paint

* Indude Exdude

v Preview Falloff

Convert to Spline

Paint Area Properties

Paint areas allow you to paint include and exclude regions with a mouse or tablet directly onto
the terrain. Paint areas require a Surface set to XY mode.

Include

When active the area creates items within the region defined by the spline.

Exclude

When active the area removes items within the region defined by the spline. Only items
generated by areas below it in the Areas List will be affected.

Paint

Paint on a surface in the viewport to add to the current area.

Erase

Paint on a surface in the viewport to subtract from the current area.
Settings

Click to open the brush settings. From this menu you can adjust the size and pressure sensitivity
of the brush and erase modes.
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’p Painter Options E' =l @

Brush Properties

Strength: 0.0 Min. Size:  0.0m
1.0
Draw Trace

Mormal Scale:

Marker

Pressure Options

v Enable Pressure

Pressure Affects m

¥ B E WK

Additive LG | l¥| = Misc
Mirror Tree Depth: 6 =

e I:. Offset: Update On Mouse Up

Gizmo Size: LagRate: 0 o

Preview Falloff

When active the falloff effect is visible while painting (enabled by default).

Convert to Spline

Converts the Paint area to a Spline area.
Properties
Mame

This area can be turned
off, but not deleted

Surface Area Properties

Due to the large number of options the majority of the surface areas settings are found in a
separate Surfaces rollout. They do however display in the Areas List and can be toggled on or off
from the Areas rollout.
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On

Turns the surface on or off.

(D Surfaces are often used to define the scattered item's position on the Z axis in
conjunction with splines and paint areas to define the region on the X and Y axes.
Occasionally you may find that the full terrain is filled with items,even though there are
spline areas in the Items List. If this is the case the usual problem is because the Area is
on, when using surfaces with other Include areas it is important to turn the Surface off.

— Plants
Select models
— Distribution Map
Mone
Scale Threshold

A - AC s

1000 =% 1000 5 o

— Surface

Mat.ID

— Boundary Checking

* Paint Size

Common Properties

These properties are found in all area types.

Select Models

When active the selected area uses a subset of the models from the Geometry list defined in the
Pick menu

Pick
Opens the pick menu. When Select Models is active the current area will use only the models
ticked in this list.
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Override Distribution Map

Used to override the global distribution map.

Scale

Scales the distribution map only for the selected area.

Threshold

Adjusts the threshold only for the selected area.

Material ID

Forest Pack Documentation

Limits the scatter surface to use faces with only the material IDs listed. To use multiple IDs, simply

leave a space between them.

Falloff Affect

Adjusts the strength of the density and scale falloff curves. Setting this value to zero disables the

effect completely.

Invert Curve

Inverts the falloff curve. Commonly use to create scatter items around boundaries and the

perimeter of exclude areas.

Boundary Checking

Forest Pack 4.3 can use 3 potential modes to determine if an object falls outside of the scatter

area and is removed.
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Edge Mode

® Point: Uses the item's pivot point to check if outside the scatter area. If true the entire item
is removed and you may get overlaps.

® Size: Uses the item's width and collision radius to check if outside scatter area. If true the
entire item is removed and you won't get overlaps but the boundary can be uneven if the
item's size is too large.

® Edge (V-Ray only): Uses the lowest Z Vertex of each of the item's individual elements to
check if outside the scatter area. If true only the individual element is removed creating a
clean edge, without slicing the geometry. Note that when using edge mode, an element is
defined as a group of connected faces that share the same material ID. These are the
same elements used by Forest Color.

To improve viewport performance edge trimming is calculated only at render time. This
means the effects of the this mode will not be previewed in the viewports. However,
previews can be enabled by holding down the left CTRL key and clicking on the Edge
radio button .
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Falloff
Density  Edit Curve

Indude Exdude
0.0m

Scale Edit Curve
Indude Exdude
0.0m > [ES5iEm -

Affect Height anly

Falloff

Density

When on, items will change density as they approach a boundary. The distance from the
boundary is controlled by the include and exclude range values and the density is defined by a
falloff curve.

Scale

When on, items will change scale as they approach a boundary. The distance from the boundary
is controlled by the include and exclude range values and the density is defined by a falloff curve

Edit Curve

Edits the the falloff curves for the density and scale effect. There are separate curves for scale
and density.
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Include

Sets the range for the falloff effect on the perimeter of Include splines and surfaces.

Exclude

Sets the range for the falloff effect on the perimeter of Exclude objects, forests, and splines.
Affect Height only

When on the scale falloff effect only affects the height of the items. Dimensions on the X and Y
axes remain unchanged.
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O Distribution Map

9.1 Overview

This rollout allows the user to specify a map to define the distribution of trees within the inclusion
area.

To allow for the most flexibility an image is used. In it, each pixel represents a potential tree
position, white pixels are tree locations, black pixels are empty space.

Using this method, we can define any distribution, from random surfaces to very regular groups.

9.2 Interface

Image

Forest can use a bitmap or a map as distribution image.

The plugin comes with some standard bitmaps included (Very Scattered, Scattered, Spread 1,
Spread 2 and more). A custom bitmap can be selected as well by clicking the button under "

Bitmap". The list of bitmaps is user customizable. In C:\Program Files\ltooSoft\forestpackpro\

distmaps, there is a text file named "index.dat". It includes a list of the bitmap names and the
associated file names.

To use a map, click the 'Map' button and select it from the Material/Map browser. All Max texture
types are supported, from static bitmaps to animated noise maps. Use the "Clear" button to
remove it.

The "Map channel " parameter is described in the following section.

Density

Lets the user choose the scale of the distribution map in the scene. The map is applied in a
manner similar to the way texture maps are applied in Max. The image is scaled according to the
defined size, and tiled in all directions.

It's important to remember that the perimeter of the forest is always defined by a spline boundary
. The distribution map only shows how the trees are arranged within that spline.

Version 18



Forest Pack Documentation

X/Y Units

Defines the size of the distribution map in scene's units. If we use small values, we will see how
the density of trees and the number of trees grows. Also, the process time and geometry size of
the Forest object is higher. The plugin is optimized for speed, but to further speed up the plugin,
here are some recommendations:

® |f the bitmap has fewer white pixels (less trees) but you set lower X/Y values, the density
will be very high but most of the processing time will be wasted in computing gaps. To
increase the density of trees, first set a higher density map, then lower the X/Y parameters
. You can see in real-time some build parameters (such as density, number of trees) with
the "Forest Stats" window. Open it clicking the "View Stats" button in the "General" rollout.

Forest Stats B frorest stat x|

Mame (First instance): Trees 1 Mame (First instance): Trees 1
Trees created; 285 Trees created: MG
Build Time: 0 ms Build Time: k&
Build Speed 351,6K trees/sec Build Speed M/A

Max.Density:  §,8K trees in area Max.Density: 14,40 krees in area
Collisions:  M/& Collisions: M/
M8 AT
/W Tree density is koo high. Increase the
%1% Size in Distribution Map parameters

The "Stats" windows also alerts the user to some warning conditions such as when the area spline is not

assigned, if the density is too high and other conditions.

® There is a limit for the number of trees created in a Forest object. This parameter is
defined in the "Display" rollout, and the default value is 500,000. Also, when the resulting
mesh has more than 100,000 faces, Forest builds the trees for the viewport using a
simplified geometry (adaptative display). All this behavior may be adjusted with the "
Display" parameters.

X/Y Pixels

These values are used to adjust the density in procedural maps, without modifying the X/Y Units
scale. These parameters are locked when using bitmaps, using the number of pixels of the image
as default value.
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Image->Map Channel

As alternative of using the X/Y values to define the density of the distribution map, it's possible to
get the scale from the UV coordinates of the surface. This mode is useful to adjust the position of
trees in more precise way, using a surface map as reference.

To use this mode, a surface object must be assigned in the "Surface" rollout. The Surfaces can
work in two operation modes, XY or UV (defined in the Surface rollout):

® XY mode: the UV coordinates are taken from the map channel defined with this parameter

® UV mode: the map channel 1is always used, and this parameter is locked.

Fit to scene

Allows the user to fit the map exactly over a position on the scene, automatically adjusting the
offset and size values. Use Pick Start/Pick End to select on the scene the position of two opposite
corners of the map. This tool is useful for adjusting maps which represent exact positions of
elements in the image, such as modified aerial views using a white pixel per tree.

Lock Aspect Ratio

Locks the X/Y aspect of the map. When this checkbox is enabled, the Y size for map is ignored
and only the X value is used.

Offset

Adjusts the offset of the map over the scene. Values are in the scene's units.

Threshold

Defines how the image pixels are converted to black/white levels when the bitmap is in grayscale
or color mode.

Rotation

Rotates the distribution map a specific number of degrees.

Max density

Set the limit of possible tree positions in the area (by default 10 million). Take care: this includes
both white and black pixels in the distribution map, so you may reach the density limit using an
empty map and low X/Y values, but not get a single tree in the scene.
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Draw Gizmo Corners
Draws the corners of the distribution map to adjust it more easily.

See also Distribution Map - Diversity and Collisions.
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10 Distribution Map - Diversity

10.1 Overview

This window defines different modes to select what type of object, from all items defined in the
Geometry List, is used when planting a tree for each pixel of the Distribution map.

10.2 Interface

Diversity

Random

Creates plants randomly, using the "Probability" values of the Geometry List. This is the default
mode.

Match Color ID on Map

This mode allows you to use colored distribution maps, where the color of each pixel defines a
type of plant. In the scattering process, each pixel of the map is matched with the "Color ID"
values of the Geometry List, taking the most similar.

Note: the "Probability" values of Geometry List items are ignored on this mode.

Although it's not needed that colors be exact, to get the best results is recommended that "Color
ID" values are the most similar possible to those used in the map. Also is better to use high
contrast colors as red, blue, yellow, green... The gaps (empty positions) can be defined using
dark pixels, where the black level is adjusted using the "Threshold" parameter.

The "Noise" parameter is used to add some random variation to the distribution.

Clusters

This mode works grouping items of same type, in a similar way that plants are found in the nature
. These groups are called clusters.
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The following parameters are used to define the cluster appearance:

® Size: use it to adjust the size of the clusters. This value is expressed in scene's units.
® Roughness: set the shape of the cluster (0% = smooth, 100% = rough)

® Blurry Edge: modifies cluster edge from sharp (0%) to blurred (100%)

® Noise: adds random items to the distribution (0% to 100%)

Clusters require to use more than one item in the Geometry List (grass and flowers, several types
of plants, etc). If not, it has no effect.

0 .
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Collisions

This feature checks the collisions between trees. It works scattering the items, and then deleting
those trees that may collide with their neighbors.

Collision checking is based on exploring possible intersections between virtual
bounding-spheres that surround each object.

To get the sphere's size of each objet, two parameters are used: Geometry Rollout->Radius, that
is defined by each item of the Geometry List, and Distribution Map->Radius, that is a gobal value
for the Forest object.. Both parameters are multiplied to get the resulting size. The value is
defined in percentage of tree's size (from 100% to 1%).

Collision results modifying local and global radius

o® . % :. ~ CYLEC e @ ® e-® o @
.-'. %.. . ...  Sag 48 ® o

'.'f'-_. P$:l% 0500029 e '.. o.-®
o . S F ..l.% 9 __.. T ® ® ...
.1" L 1 pell oo ) ®

Ol00% Globatoon  ®I80% Govaioow  ®10%  Giobal 150%

The "Height" value is used to define the sphere's center in Z axis. The default value (0%) builds
the sphere at ground level, increase it to improve the collision detection when using tall trees
with large treetops.
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Radius: 100% Radius: 100% Radius: 60%
Height: 0% Height: 50% s Height: 80%

Ll i

Take care when using Collision Detection: if you increase the density of trees (using a dense map
or lowering the X/Y parameters), you may get the same number of trees, because most of them
are discarded by collisions... but the plugin will be have an extra workload in order to process
them. This condition is alerted in the Forest Stats window, when the number of discarded trees is
greater than 50%.
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11 Surface

11.1 Overview

In most Forest scenes, we will not be placing trees over planar surfaces, instead we have hills,
mountains, etc. With this panel we can choose the surface that the trees will be placed over.

11.2 Interface

Surfaces List

In the Surfaces list we can choose the objects which represents the terrain. They must be a
simple meshes (we cannot use groups, etc.), and the trees will be placed along the local Z axis.

The "Add" button ( ﬂ) add a new surface to the list, and "Delete" ( ﬂ) removes the selected

item. E Add multiple elements from a list of objects selected from the scene.

If we modify the terrain, the objects will not be adjusted automatically over the new surface, the

oy . o
user must press the Q button to process the changes through Forest. This may be a limitation
for scenes with animated terrain, but it's implemented this way because Forest builds an internal
table with the terrain characteristics to optimize the speed of tree placement.

Anyway, this table is common for all Forest objects, so when we have used the same surface for

several Forest objects it is only necessary to use the < button in one of them. All trees will be
placed automatically. Use the 'Auto' checkbox if you need to update the surface automatically (
this may add a performance hit for complex surfaces).

Mode
Forest can use the surfaces in two modes of operation:

® XY mode: the items are scattered using the XY plane of the Forest object (in local
coordinates), and then placed on the surface moving each object along its Z axis. This
mode is best suitable for smooth terrains and used by default when there is not a surface
assigned, using the Area splines as boundaries.

® UV mode: uses the mapping coordinates of the surface as alignment guide for the
Distribution map. This mode is best used on rough terrains or to scatter items over convex
3D objects (as a sphere). Note that using this mode, the UV coordinates must be precisely
defined to get a coherent result.
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Note: Several Forest features are not available in UV mode: Area splines, Bitmap rotation,
Dist.Map Channel (locked to 1) and "Link to Surface" on Custom Edit mode.

Randomize Stacked

By default Forest uses the XY position of each item to compute its random seed. If you scatter
items that are aligned on the same XY coordinates (i.e. adding several stacked surfaces), all of
them will share the same random properties.

Turning on this parameter will avoid this issue, generating different items on stacked surfaces. It
is disabled by default, to keep compatibility with scenes created with previous Forest versions.

Scattering by UV coordinates

11.3 UV Transform

You can use the UV Transform parameters to modify the alignment and scale of the items

according to the UV coordinates. These options are available only in the UV Surface mode.
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11.4 Direction

Lets you to modify the direction of the items relative to the surface's normal: -100 (Down), O (
aligned with the Normal), 100 (Up).

[ S LT LT (e ST T

Scale to fit sloped areas

When using sloped terrains on XY mode, this may do that not all trees be equally spaced. This
effect is more noticiable in high density distributions (as grass fields). To fix it, you can use this
option to scale the items's width proportionally to the surface's slope.

When "Scale to fit" is enabled, the Direction value is fixed to O (Normal aligned). This feature is
not used on UV mode.

No Surface g Scale to Fit

11.5 Altitude Range

These parameters define the altitude limits for tree placement. When the "Limited" checkbox is
enabled, trees will only be created in the range specified by Top and Bottom.

The Fallof parameters allows us to define density and scale curves based in the item's altitude.
The faloff scale is applied in the range defined by the Top and Bottom values.

11.6 Slope Angle Range

Limits the creation of trees over a range of slope terrain. O degrees is equal to a horizontal
surface, and 90 degrees is a totally vertical surface.
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11.7 Custom Edit Mode only

Since in Custom Edit mode must be possible to move each tree individually (including Z axis),
these parameters defines how the trees are placed over the surface: automatically, if "Link to
Surface" checkbox is enabled, or manually using the "Place Trees" button.
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12 Tree Editor

12.1 Overview

To add scatter items Forest can work in two modes: Generate or Custom Edit. In Generate mode,

items are created randomly within the regions defined in the Areas rollout according to the
Distribution rules. The Custom Edit mode allow for a precise level of control, allowing you to edit
and create individual items manually. A typical workflow might involve working between the two
modes by creating an initial scatter of a large area of plants using Generate mode and then
switching to Custom Edit to make final adjustments to individual objects to fine tune the
composition.

12.2 Procedures

To manually add individual scatter items
1. From the Tree Editor rollout, click Custom Edit.

2. Enable the tree sub object level from the Modifier Stack Display or by clicking ﬂ

3. To determine which items to use from the Geometry list select one of the following modes.
® To use a specific model, click Model and select an item from the drop down list.
® To use a random item from the Geometry list, click Random.
® To use a sequence of items as defined in the Geometry list, Click Sequence.

4. Click Add.

5. Click in the scene to place a new item.

@ ® New items will be positioned at zero on the Z axis unless a Surface area is being

used and the Link to Surface option is active in the Surfaces rollout.
Custom Edit mode

v Link to surface

Place Items

® Alternatively you can set 3DS Max's Grid and Snap settings to Face to click on
any geometry to determine the Z position of a new item.
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B Grid and Snap Setfings o @ /[

Snaps Options Home Grid User Grids

Standard -

Grid Points Grid Lines

Pivot Bounding

Perpendicular Tangent
Endpaint
Midpaint

Center Face

Clear all

To manually edit existing scattered items
1. From the Tree Editor rollout, click Custom Edit.

2. Enable the tree sub object level from the Modifier Stack Display or by clicking ﬂ .

3. You can now select individual or groups of trees in the viewport. Edit them using the
following methods:

® Manipulate them with the translate,rotate and scale tools in the usual way.
® Randomise geometry by clicking Randomise.
® Randomise transforms by clicking Re-Seed.

® Specify the geometry used from the items list by selecting an item from the
geometry drop-down list

Properties ction)

_fp_crested_dogstail -
_fp_comment_bent_detail
_fp_crested_dogstail_de
_fp_festuca_rubra_3
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To attach another Forest object

To attach a single Forest object

1. Click Attach > Single.

2. Click the Forest object to add from the viewport.

To attach multiple Forest objects

1. Click Attach > Multiple.
2. Select the Forest objects to add from the Attach List.

3. Click Attach.

To detach selected items to a new Forest object

1. In Custom Edit mode, select the items to detach.

2. Click Detach.

To create items along a path

1. Click the Along a Path spline picker and select a spline.

2. From the Properties (Selection) group, select the mode from Model, Random, or
Sequence.

3. In the Spacing input, enter the distance between objects. Alternatively click In Vertex
Positions to place an item on each spline vertex.

4. If the objects should rotate to follow the direction of the spline, click Follow Path

5. Click Create.

When creating items using paths or reference geometry the default behaviour is to
delete any existing items. To retain any items already created in the forest object,
deselect Delete Existing Items.
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To create items on reference geometry

1.

Click Select Objects and select the reference geometry from the Create Items in Objects
Positions list.

From the Properties (Selection) group, select the mode from Model, Random, or
Sequence

Choose the technique for positioning scattered items:

® Pivot places one object at the pivot point of each selected object.

® Face Centers places one object on the centre of each face of a mesh object.
In pivot mode you can click Scale to match the scale value of the source objects.
Click Align to match the rotation of the source objects.

Click Create.

Using mesh triangles as reference
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12.3 Interface

Tree Editor
Mode

Generat
Attach

L
-
vk
Single Multiple
® Custom Edit gl ple
32 Items in Object
Add Items
Model

_fp_african_daisy_smz

#* Random

Seguence

Creation Toals

Along a Path  Cirde001

* Spacing 2Z0m 3

Properties (selection)

Subltem =

0 Ttems selected

v Align v Scale

Mode

Generate

In generate mode scattered items are placed within regions defined in the Geometry List
according to rules defined in the Distribution rollout.

Custom Edit

In custom edit mode, items can be created one at a time or distributing along paths or on the
pivot points or faces of reference geometry. Once created, scattered objects can be edited
manually using Max's default transform, rotate and scale tools.
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When switching between Generate and Custom Edit mode, Forest Pack will always display a
warning to ensure you don't accidentally lose any changes.

Generate »Tree Editor

' Forest Pack £3

Tree Editor » Generate

' Forest Pack £3

Switching to Generate mode will
and the Forest object will be recre;

To edit the items, you must also activate the sub-object level using the Modify Stack Display on

the Modify panel, or by clicking E .

Add ltems

This button creates individual items by clicking in the scene. To use is you must be at the Trees
sub-object level.

There are three selectable modes, that work when adding individual items and using the
Creation Tools (described below).

® Selection. Uses the plant type defined in the Properties combo.
® Random. Select a random plant from the Geometry List.

® Sequence. Gets the plants models sequencially, as defined in the Geometry List.
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Properties (Selection)

Lets you to change the type of plant (from the models defined in the Geometry List.) for the
selected items.

Sub ltem

When using Groups as Custom Objects this value defines the index of the element inside the
group.

Select By Type

Selects all the items that use the type defined in the selection combo box.

Randomize

Randomizes the plant type for all items selected.

Reset Size

Resets the scale of the items selected.

Re-Seed

Applies new random seeds to the selected item's transform setting. Use this option to
re-randomize items that have been created by a copying process.

Store Transform

Stores the current random transformations into the items properties, and disables the
randomness settings. Useful for attaching Forest objects but maintaining their original
randomised transforms.

Detach

Detaches the selected elements to a separate Forest object.

Attach

Attaches items from other Forest objects. You may select a single object or choose from a list.

Consolidate Geometry List

If enabled, the plugin will try to match the Geometry Lists using the Name property and the type
of geometry. If not, Forest will append the items from the Geometry List of the attached object.
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Creation Tools

These tools are used to automatically build elements inside a Forest object.

Along a Path

Distributes trees along a path defined by a spline, use evenly spaced to place at a measured
distance or create an item for each vertex of the spline.

Reference Objects
Places items using the position of other objects as reference. Several modes are available:

® Pivot Point: the point of creation is the Pivot Point of the referenced objects. For example:
to create a group of trees in specified points, which have been defined in an external
program (such as AutoCad) and imported to 3D Studio Max as dummy reference objects.
Align and Scale can be enabled to copy the scale and alignment based on the reference.

® Face Centers: creates a element for each face of the referenced meshes. If the Align
option is enabled, items are aligned with the face, using as X axis a vector from the center
to the farthest vertex in the triangle.

Alignment is calculated using a vector calculated from the center to the farthest vertex.
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13 Camera

13.1 Overview

One of the problems with using billboards, is that items must be rotated towards the camera, in
order to get a 3D look. Forest can do it automatically, using the Camera features included in this
rollout.Also, the plugin allows us to build only the items which are inside of the camera's frustrum,
allowing to create large areas of vegetation while minimizing the number of scattered items.

13.2 Interface

Camera

With the Camera button we assign a camera in the scene, "Clear" un-assigns it. "Copy" assigns
the current camera to all Forest objects in the scene.

Auto assign to active view

This checkbox automatically assigns the camera to the active view, if any.

Apply to Look-At

When on, assigns also the active camera to Look-At target (see below). This is not necessary for
billboards (Geometry->Template mode), which do it automatically.

Area

Limit to visibility

Using this checkbox, we limit the items only to the areas covered by the camera's field of view.

Expand

Sometimes (in scenes with camera motion), it's possible that some items will appear or disappear
"suddenly" from the edge of view because the vision limit is very narrow. With this parameter, we
can widen the field of view. With a 10% or 20% value, the effect is solved in most scenes.

Far Clipping Plane

This parameter limits the creation of items beyond a specified distance from the camera. This
value is defined in scene's unit system.
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Back Offset

Extends the creation of items behind the camera's position. Use it in combination with the "
Expand" parameter, to fix the problem of items and shadows appearing suddenly from the edge
of view.

Copy Parameters

Copy the current camera parameters to all Forest objects in the scene.

Look-At

When enabled, rotates the items to ook at a specified object (the camera or other node from the
scene). This option is commonly used for One-plane billboards, but it also works with Custom
Objects.

LOD (Level of Detail)

When on Forest LOD objects added to the scatter are active. This features enables you to switch
objects based on distance from the camera or by the size of the objects in the rendered view.

Override Max. Distance

If zero Forest uses the Maximum Distance value specified in the Forest LOD objects. If greater
than zero, the value specified in Forest LOD objects are ignored and the value specified here is
used.

Use Environment Range

When enabled, the maximum distance is derived from the Environment Range settings of the
active camera.

Use Look - At Target

When enabled Forest uses the pivot point of the object assigned in the Look-At Target slot as the
origin for the Max Distance measurements. This enables you to separate the camera and origin
used for all LOD calculations.

Density/Scale Falloff
Lets you to define density and scale curves for camera distance.

If "Use Environment Range" is on, the range values are taken from the Canera's environment
range. This allows us to assign different ranges from each camera easily.
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Be careful if you use falloffs with camera motion, because items may appear or disappear
suddenly (the distance to camera changes when moving).
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14 Shadows

14.1 Overview

The Shadow rollout is used to define the shadow casting behaviour when using billboards. Most
of these features are not applied with mesh trees.

Forest can use two types of shadows for the trees: XShadow and Raytrace.

XShadow must be used exclusively with the Scanline renderer, for other render engines as
Mental Ray or VRay use the Raytrace mode.

In the Raytrace mode, Forest automatically builds some additional planes, one vertical and the
other horizontal, which are used ONLY to project the shadows. By default, these planes are not
visible in the viewport or rendering.

Raytraced shadows requires Forest Material to work, because this plugin does the job
of hiding or rendering the shadow / texture for each plane. Be sure that the material
applied to the Forest object uses the "Forest Material" plugin as a base.

14.2 Interface

Use Fake Shadows

This checkbox allows you to disable all XShadow and raytrace options, and cast standard
shadows just as any other object in the scene.

XShadow / Raytrace

Vertical

When enabled, this option builds a vertical texture for the trees.

Horizontal

Same as the horizontal shadow. The shadow mask must be defined in the "Forest Material"
plugin.
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Z Offset

Adjusts the separation of the horizontal shadow from the base of the tree. The value is defined as
a percent of the height of the tree. By default it is 5%, you may use higher values if the shadow is
hidden by the terrain or the bias parameter in the light is too low.

Width Scale

Use this option to scale the horizontal shadow. A value of 100% will create a shadow of same size
as the tree's width. Note: the horizontal shadows created by Forest are squared.

Cast opacity mask for Custom Objects

By default, the plugin casts opacity masks only for trees created from templates. Enable this
option to use also on "Custom Object" trees.

Raytrace

Pick/Clear

Assigns the light which casts the raytraced shadows. The shadow planes created by Forest will
face this light automatically. "Clear" un-assigns it. Without a raytrace light assigned in this
parameter, Forest doesn't build the shadow planes. The "Copy" buttons assigns the current Light
to all Forest objects in the scene.

Hide Planes in viewport

By default the shadow planes are hidden, use this checkbox if you want to see these additional
geometry in the viewports. This checkbox doesn't affect the visibility on the render; if a "Forest
Material" is applied to Forest, the shadow planes are not visible but cast shadow. Without "Forest
Material" the planes are visible and cast shadow (just as any other geometry in the scene).

Prevent Self-shadow

In Mental Ray and VRay, enable this checkbox to avoid that a tree cast the shadow over itself.
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Every tree over itself

Defines how the self-shadowing detection is applied, to the full object (trees don't cast shadows
to other trees on the same Forest object) or only each tree to itself.

{If you use Mental Ray, set Shadows Mode to "Simple" or "Sort", but not "Segments" (Render
Setup -> Mental Ray Renderer> Renderer> Shadows & Displacement -> Shadows Mode). This
mode is not supported by Forest.

@ If you use Mental Ray, set Shadows Mode to "Simple" or "Sort", but not "Segments" (
Render Setup -> Mental Ray Renderer> Renderer> Shadows & Displacement ->
Shadows Mode). This mode is not supported by Forest.
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15 Transform

15.1 Overview

In a natural distribution, trees have different orientations and sizes. With this rollout we can apply
these variations to the elements.

15.2 Interface

Translation

When enabled, this value defines a random translation of the tree object over its original position.
The translation come defined as a percentage of the width of the tree for X/Y and height for Z.

Note: This translation is applied after placing the tree over its position (as indicated in distribution
map), so it's possible if we apply a high random translation the tree will be placed outside the
area spline. If this happens, we must lower the translation value or modify the area spline until
trees are placed in a good position.

Rotation

These parameters apply a random rotation over each axis. The degree of rotation ranges from
Min to Max values specified (from O to 359 degrees).

Note: the rotation is not applied if "facing camera" checkbox is enabled in the "Camera" rollout.

Scale

Use this option to apply a random scale for each tree. It's possible to define independent ranges
for XYZ, and to lock the aspect ratio with the "Lock aspect ratio" option.

Probability Curves

Lets you to define the probability of each random value in the rotation range (X axis = Min/Max
range, Y axis: 0-100% probability).

Version 18



Forest Pack Documentation

0000000000
RO oS N oS R oS ol o ol o %
S 2 & 0¢:¢0¢0~
O Q@ Q0O
Co 00009 ¢-
ot —==h 9O

(Bl -2 3 | -2

rm%ﬁ.n R IE.—'— -ﬁ éj _.,__._
BEREI:
i = E'AL

Rotating to discrete values of 0°, 90°, 270° using a Probability Curve
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Non-uniform scale distribution using a Probability Curve

Using Maps

The map parameter may be used to adjust the transform amounts using a texture map.
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If the 'Color map' checkbox if off, the map is evaluated in monochrome mode, the white color is

Forest Pack Documentation

considered as the Max rotation value, and the black color as Min.

Turning on 'Color map', the RGB components of the image are used to define the scale for each

axis, in this way: Red color-> X, Green color->Y, Blue color->Z.

If you have three monochrome scale maps, one for axis, it is easy to combine them in a unique

RGB map using a Composite texture, in this way:

[- Bask Parameters Red-=X]
reset Al [vap: [ Map 20 (Swirl ) |
|- Chamnels ]
" Normal Red = | Monodhrome -
" Menachroms Green = |I&re R [ 2 =1 i
¥ s = ot avers: [ 9
'Qrm Apha = |Cne = Layer 3 I
E "~ Bask Parameters Green->Y) IJ. 0 00 opsoty:[i00 J E
ResetAl |Map: - Map =1 {Noise ) [ [ada _ |
|- Channels ] J
P « [2er > 000 cq:adnrl _! =
T = — ==I| o 6
¢ Monachrome Green = |Monochrome - |
¢ Invert Bue = |Zere - Layer 1 ]
® Custom Alphs = |One = (] Elﬂ Opadty: [100.0 _I oo
IJ [ada None | i)
Bosic Parameters Blue=7
Resetal [meo: [ ree s (Gadenty |
|- Channels |
 Hormal Red = |Zero -
¢ Monochrome Green = |Z210 -
I [rnvert Blue = |Monachroms -
& Custom Alpha = [One -

Probability Map

Activating this option uses a map to define a probability amount for the random range defined by
the Min/Max values. Scatter objects in black areas of the map will not be randomised, objects in
white areas will receive a value selected from the full range.

44444444‘4444‘
. |

Using a probability map to control scale randomisation. (black = no randomisation, white = full randomisation)
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Mirroring

This option flips the tree horizontally, creating a mirror image. It is useful to increase the variation
of the textures without using additional maps. By default, it's applied only to trees created from
templates, enable the "Use on Custom Objects" checkbox to use on custom object trees as well.
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16 Material

16.1 Overview

Applies a random color tint to the items. There are two possible modes of operation, tint by
gradient and tint by map.

16.2 Interface

Color Tint

Get Color from Gradient

You may define a Color Range by clicking in the color boxes, and the Random Strengh range
determine the magnitude of tint applied, from 0 to 100%. Use Min=0 and Max=0 to disable the
effect.

Get Color from Map

Forest uses a custom map as tinting source. With "Random Values", a random pixel from the map
is taken for each tree, and "As Texture" applies it as a standard Max texture.

By default, Forest uses the parameters defined in the Distribution Map rollout (X/Y, offset, rotation
...) for scaling, but it's also possible to get the mapping coordinates from the surface, if there any
assigned in the Surfacerollout, and a value greater than zero is assigned to "Map Channel".

w Map

Map B1E [ Swad | I
© Random vakiet
& As tesduie on Suslace

W Uze on Custom Objects

Grass with procedural tint map
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Color Tint requires Forest Material or Forest Color to work. Be sure that the materials

used in the Forest object (assigned in the Geometry rollout or applied directly to the
object) use one of these plugins. "Forest Material" is a custom Material included with
Forest Pack, and "Forest Color" is a 2D texture map. Without them, Color Tint won't
work.

It is possible to customize the tinting options for each material using the "Override" option. See
Forest Material and Forest Color reference for details.

_cobors Iﬁldlmtﬁufp]l -

& Random vahess w
' .ﬁ.ﬂmw,l'a on Suriace

Random discrete colors on custom materials
Forest Material + Ovemide Tint + Gradient Ramp

16.3 Forest Shader

Forest includes a custom shader that enhances the rendering of billboards. Currently, it's only

available for Mental Ray. The following parameters adjust the behaviour of this shader. As all
options on this rollout, require the use of materials based on "Forest Material" plugin.

Trace Depth

Maximum raytrace depth used to compute the opacity maps, default value is 3.

Opacity Level

Defines the minimum level of opacity of the mask textures used by Forest Material. As instance, a
value of 0.8 considers all pixels darker than RGB=204,204,204 (255*0.8 = 204) as opaque. It's
used to optimize the computation of opacity maps.

These parameters are used to speed up the rendering, but in some situations using lower values
would create image artifacts. To disable them use Trace Depth=99, Opacity Level=1.0.
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Self-illum factor

This parameter works as a multiplier of the self-illumination value, for all materials used by the
Forest object. Use it to adjust the Self-illum effect, without having to modify each material
individually.

I[rradiance Color

Defines the effect of global illumination on the Forest object when "Final Gathering" is enabled (
Mental Ray renderer options).

To get the best results with these parameters, we suggest this configuration for Mental Ray
scenes:

With Final Gathering enabled:
® Forest Self-illum factor: 20% to 100%

® Material Self-illum: 50%. Create all your new materials with this value, you won't need to
modify it... use Sl factor instead. All materials of the Forest libraries have 50% by default as
well.

® Irradiance Color: default

® Use S| Factor + Irradiance to get the desired global illumination over the trees.
Final Gathering disabled:

® Forest Self-illum factor: 20% to 100%

® Material Self-illum: 50%.

® |rradiance Color: not used
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Render Engine

[VRay =]

| Corvvert Standard Matesialz bo VA ayMental
[~ Trace reflections

Iv Apply Fonest Matesial [bllboards only)

[v Dizable Fikering foe Dpacity Maps

Iv Modify Custom Dbjects mateialz

Diffuze Maps

b Apphy Forest Color— RGE Lewvel[TD %
F# Esclude matedial: wsing thess names:

) Material Optimizer ==

[tnak bark]

Optimize

This tool helps you to convert and optimize the materials used by Forest, selecting automatically
the best settings for each renderer. It includes the following features:

® Convert Standard Materials to VRay (VRayMtl) / Mental Ray ( Arch & Design).

® Apply Forest Color to the diffuse maps.

® Apply Forest Material (billboards only).

® Disable filtering for Opacity Maps (recommended for leaves using transparencies).

To demostrate the benefits of the Material optimizer, we have created this free Alpine Lake

scene which uses XFrogPlants. The render time is over seven times faster over using standard

materials.
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x7'5 Faster Render

XFrogPlants + Forest Material Optimizer
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17 Animation

17.1 Overview

The animation rollout provides a number of options to allow you to control animated scatter
objects. By default animation is turned off so animated scatter objects will appear static, to use
animation, choose from one of the following 4 methods.

® Follow Geometry: All scattered instances animate in sync with the source geometry.

® Random Samples: The starting frame of scattered instances is randomised from a fixed
number of sample points along the timeline.

® Random from Map: The starting frame of scattered instances is selected using a grayscale
map from a fixed number of sample points along the timeline.

® Frames from Map: The absolute frame of the scattered instance is controlled by a
grayscale map.

See the Interface section below for a more detailed description of these modes.

17.2 Procedures

To sync animations

1. Add 1 or more animated scatter objects from the Add Geometry rollout.
2. From the Animation rollout, activate Follow Geometry.

3. To preview the results in the viewport, deselect Animate Only at Render Time.

To create randomised animations

1. Add 1 or more animated scatter objects from the Add Geometry rollout.
2. From the Animation rollout, activate Random Samples.

3. Set the number of samples using the Count value. Higher numbers create a greater
variation.

4. Set the number of frames between each sample using the Time Offset parameter. Time
Offset and Count work together, for example a time offset of 10 and count of 3 will
randomly select between animation start points at frames 0, 10, and 20.

5. To preview the results in the viewport, deselect Animate Only at Render Time.
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To control the starting frame of an animation using a map

N

Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Random From Map.

Set the number of samples using the Count value. Higher numbers create greater variation

Set the number of frames between each sample using the Time Offset parameter. Time
Offset and Count work together, for example a time offset of 10 and count of 3 creates
samples at frames 0, 10, and 20 that will be selected by the map.

Click in the map group to open the Map Browser and select a

grayscale image or procedural map. Alternatively assign a map by dragging onto this
button from the Material Editor.

To preview the results in the viewport, deselect Animate Only at Render Time.

To control the absolute frame of an animation using map

Add 1 or more animated scatter objects from the Add Geometry rollout.
From the Animation rollout, activate Frame From Map.

Define the animation range to be controlled by the map by entering the appropriate frame
numbers from the timeline in the Start and End value boxes.

. Click in the map group to open the Map Browser and select an

animated grayscale image or procedural map. Alternatively assign a map by dragging onto
this button from the Material Editor.

To preview the results in the viewport, deselect Animate Only at Render Time.

17.3 Interface

Disabled

The plugin doesn't apply animation to the trees. All geometry, including templates and custom

objects remain static.

Follow Geometry

Forest follows the mesh animation of the source trees (defined in the Geometry rollout), for each
frame. If you use the built in billboard templates, only the "Low/Medium/High Animated Planes"
templates have animation applied. For "Custom Object" trees, the animation depends on the the

selected objects.
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Random Samples

Using this option, Forest takes several sample points along the timeline, and selects them
randomly to set the starting point for the animation. The "Samples" parameters, defines the
number of mesh samples, and "Time Offset", the difference in time between them, starting from
time O.

10 Frames 10 Frairas 10 Fraimes

In this example, Count=4, Time Offset=10 (using frames as unit-time), will take four mesh samples at frames 0, 10,

20, 30.

Random from Map

This option works similar to Random Samples, but uses a grayscale map to select the sample
point from which the animation will start. The UV coordinates for the map are derived from the
surface assigned in the Surfaces rollout.

|
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11 Frames 10 Framas 1G Frames

Following the above example of Count=4, Time Offset=10, a black pixel in the map will take an animation sample

at frame 0, a white pixel at frame 30, and interpolated samples for pixels in the gray range.

Frame from Map

Using this option you can control the absolute frame of an animated object using a grayscale
map. This map can then be animated to control the playback of the scattered objects. The
animation range controlled by the map is defined using the Start and End parameters.
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J) start Q} End

In this example the Start is set to 0 and the End is set to 30. A black pixel on the map will set the object to frame

0 and a white pixel sets the object to frame 30. Other grayscale values smoothly interpolate between these two

frames.
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18 Display

18.1 Overview

18.2 This rollout allows the user to define different
levels of visualization for viewport and render modes.

18.3 Interface

Display

Mesh/Adaptative/Proxy

These options allows Max to display the items using the original geometry or a proxy (Planes,
Pyramid, Box, Thin Box, Plant). For proxy objects, it's possible to adjust the transparency and
display them in wireframe mode.

The Adaptative option, automatically switches the display mode when the number of faces
exceeds the specified value.

Points Cloud

This is an ultra-fast view mode which lets you to see a 3D preview of plants on Viewport. Some of
its features are:

® Adjustable density of points, both to the local object of global to all Forest objects.
® Color by ID or from Material. Forest gets the material color from the Diffuse slot.
® See Random Tint colors in real-time.

® Fake shading effect, to enhance 3D look. Adjust it using the Shade slider.
Max ltems

Defines the maximum number of items drawn on screen. This is an approximated value, Forest
adjusts the density of the distribution to not exceed this limit.
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Manual Update

Set the update mode of the selected Forest object: automatic or manual (clicking the Update
button).

Disable Object

When enabled the object is disabled in the viewports and the render.

Freeze All

This option allows you to Freeze ALL Forest objects in the scene, except before rendering a
frame. It is useful to reduce the load on 3D Studio when there are a lot of objects.

Render

Mesh/Adaptative/Proxy

These options allows Max to render the items using the original geometry or a proxy (Planes,
Pyramid, Box, Thin Box, Plant).

Simplification Level

With "Simplification Level" we can reduce the number of items created by the plugin. With the O
value, all trees are built, and with 1,2, etc., the number of trees is reduced progressively.

Normally, we leave the simplification level to O for normal render. Higher values are used to
quickly reduce the final density of trees over the scene without changing the distribution map
parameters.

Render Mode

This parameter defines the behaviour of Forest when it creates the elements for rendering. The
possible values are "Automatic" and "Meshes".

In "Automatic" mode, the plugin uses all capabilities of the renderer to get the best results in
complex scenes, creating automatically instances, meshes or proxies according to the type of
objects defined in the Geometry rollout. Currently, this mode is used only in Mental Ray and VRay

In "Meshes" mode, Forest creates a single mesh containing all trees. This mode may useful, as
instance, if you want to create a Forest object that uses another Forest as tree sample (this must
use "Meshes" mode to work with MR/VRay).
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Max ltems / Max Faces

Limits the maximum number of items or mesh's faces created by the plugin. The default value is
500,000 objects and 5 million faces. When this limit is reached, the plugin builds an "F" icon
instead of trees, and the Forest Stats window shows a warning message.

Note: The "Max Faces" value is ignored in Mental Ray / VRay and "Automatic" mode, since these
renderers are not limited by the number of faces when working on this mode.

Hide Custom Objects before rendering

If this option is on, the plugin hides from the render the objects assigned in the Geometry->
Custom Object rollout. Use it to avoid rendering the high-poly meshes, proxies and other objects
that are used only as source geometry for Forest.
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19 Library Browser

19.1 Overview

The library browser allows you to easily organise, access and share objects and presets that you
use regularly. Forest Pack comes with an expanding range of objects including 2D Billboards,
flower, grass and rock 3d models and grass, leaf and stone presets. Additional libraries from
XFrog, Evermotion and HQ Plant can be purchased that integrate easily with the library browser,
or custom libraries can be created from your own objects.

@ Object types

The library is able to store three types of object:

® 2D Billboards use bitmap textures stored in a material library. These are mapped
to 2D planes generated automatically by the plugin. No geometry is stored in the
external file

® 3D Objects use geometry stored in an external .max file. When used the object
can be either XReferenced or merged into the current scene. Forest Pack will
use the material assigned to the object in the original file unless specifically
overridden.

® Presets import complete Forest Pack objects, including any combination of
Billboards and 3D objects plus all the rules that govern their distribution and
appearance. Using presets allows you to quickly share and reuse complete
styles without having to set the Forest Parameters for each use. Presets are
simply created by referencing a completed Forest Object in an external .max file.

Version 18



Forest Pack Documentation

19.2 Procedures

To open the Library Browser

® To access the library go to the Geometry rollout, select or add a geometry item and click
on Properties>Library to open the Library Browser.

To use a library object

1. Use the Tree Navigator to locate your library.

Ef Libraries
= M Forest Library
= W20
E Shrubs
E Trees
= W 30

B Flowers&grass
B8 Stones
= 1‘5‘ Free f'-.-'1udr.ek._
m HOPlants Free
= W Presets

2. Select the library object you wish to use from Items Grid.

Rock 03

Impart Selected

3. Either double click, right click and select use item, or click to use.

4. Set area, distribution, transform and other settings as appropriate.

Version 18



Forest Pack Documentation

To use a preset

1. Use the Tree Navigator to select your presets library.
Select the preset you wish to use from the Items Grid.

Either double click, right click and select Use Item, or click Import Selected to use.

P @D

Most of the Forest Pack parameters will be imported, update the Area or Surfaces controls
if required.

To manually choose a material for a renderer

1. Select the item you wish to use, note that not all library objects have multiple materials
assigned.

2. From the options bar at the bottom of the Library Browser, go to Materials > Using and
select the renderer you wish to import a material for from the drop-down list.

Automatic Selector

Automatic Selector
Standard Materials

MentalRay Materials

VRay Materials

3. Either double click, right click and select Use ltem, or click Import Selected to use.

To merge the library object's geometry into the scene

1. Select the item you wish to use.

2. From the Options bar at the bottom of the library browser, change the 3D Objects Creation
mode to Merge into Scene

19.3 Interface

The Library Browser is divided into three parts. On the left is the tree navigator, where you select,

edit and open your libraries. These are organised into two types of folder. System folders,
represented in blue, are the default libraries that come with Forest Pack. These are read-only and
cannot be modified. Editable user folders are green and are where your custom libraries can be
found. On the right is the Items grid, where the contents of the selected library are shown. Along
the top is the toolbar, with several command buttons.
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Tree navigator

The tree is used to navigate, edit and select libraries. To use simply use the mouse or keyboard
to expand folders and select libraries as you would in Windows Explorer, the following operations
also apply:

® To open a library: left click on it.
® To move libraries: left click and drag to the new location.
® To copy libraries: left click + CTRL key while dragging.

As mentioned system wide folders are read-only, if you wish to modify them, simply make a copy
to a User's library folder. Libraries can be copied between computers or shared in a network.

ltems grid

To choose an item, use the mouse or the arrow keys. The selected item is identified by a yellow
border. To use the selected item in Forest Pack Plugin, press return, double click, right-click>use

item, or press "Import Selected". To add multiple items at same time, select while pressing the
SHIFT or CTRL key and press Enter
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When using Billboards, each item has an associated Width, Height, Z Offset and Center
Displacement values. To use these parameters in the Forest object, ensure the "Get Size from
Library" checkbox in the Geometry panel is on.

Options Bar

At the bottom of the screen are the options to control various aspects of how the library item is
imported into the scene

Materials Using.

Library items can be configured to use a different materials dependant on renderer. This drop
down list allows you to manually select which materials to import, or to let Forest Pack
automatically select the best material for the current renderer, leave on automatic.

On Duplicate Material.

Determines what to do in the event that a material applied to an item shares a hame with a
material already in the scene. Options include using the scene material, replacing the scene
material with the library material, or prompting a decision from the user for each item.

3D Objects Creation.

Defines how to import the geometry, the default option is to XRef to the library files but it is also
possible to merge the original geometry into the scene.

Show Warnings.

Turns on/off any warning prompts related to these settings.

Toolbar
Icon Name Description
n Previous Go to previous folder.
folder
n Next folder  Go to next folder.
m Up one Go to parent folder.
level
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Name

Refresh
view

Ordering

Language

Zoom out

Zoom in

Zoom slider

Save
changes

Edit
preferences

Search
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Description

Forces the reload all folders, libraries and items from disk.

Choose to view items ordered in alphabet or inverse order.

Choose to view the common name or scientific names in the
grid.

Decrease size of thumbnail images.

Increase size of thumbnail images.

Click and drag right to increase size of thumbnail images

and left to decrease size of thumbnail images.

Saves to disk the changes in current library.

Open the catalog preferences window.

Write text to filter items.
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20 Editing a library

20.1 Overview

In addition to the tree libraries included with Forest Pack and a comprehensive range of Xfrog,

Evermotion and HQ Plants expansions it is often desirable to create and edit custom libraries to
re-use and share commonly used assets. The library browser allows you to easily organise and

edit your libraries and create new 3d objects and billboards.

® User editable libraries are available to Forest Pack Pro users only.

® Only user libraries are modifiable, to change the built in libraries they must be
duplicated to a users location.

In this Section:

20.2 Procedures

To add and modify library locations

® Forest Pack can access objects from a number of different libraries. These are located
automatically from a list of folder paths defined in the preferences. Folders can be
stored locally or in a shared network location.

1. With the library editor open go to File>Preferences... or click the preferences button from
the top toolbar.

2. The Library Paths rollout shows a list of all the locations currently being used. To add a
new location click on the Add button and navigate to the folder for your libraries.
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Metwork Path

3. In the Label field enter a location name to display in the tree navigator.

4. Click Use Path to add the location to the library and return to the preferences.

Library Paths

D:\My Documents'Libraries
JocumentsLibraries 2

Dy
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XML Document
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Microsoft Access ...
Microsoft Access ..
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5. Click OK and you should now see all the sub folders and libraries displayed in the tree
navigator on the left hand side of library browser.

Alternatively to modify or update an existing location:

1. With the library editor open go to File>Preferences or click from the top toolbar.
Setting button.

2. To modify a location select it from the library paths list and click Modify.

3. Navigate to the root folder of the new location and select Use Path.
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To organise and Create new libraries.

Each library location path can be further organised into subfolders. Forest Pack will scan these
subfolders and replicate the directory tree in the tree navigator found on the left hand side of the
library browser window. From this panel folders and libraries can be created and deleted using
the procedures outline below, and the directory structure easily reorganised using drag and drop

To create a subfolder:

1. With the Library Browser open, in the tree navigator on the left hand side, right click on a
user library and select Create Folder.

2. A new folder has been created. The name will be highlighted, type in a new name for the
folder.

Alternatively to create the subfolders directly in Windows Explorer:

1. Navigate to the library location in Windows Explorer or locate it automatically using the
Library Browser by right clicking its name from the tree navigator and selecting Open in
Shell...

2. Create your directory structure in the usual way using Windows Explorer

3. When you are done, update the view in the Library Browser to reflect the new directory
tree by clicking on the Refresh button (button image)from the top toolbar or select from the

View menu.
4 | lib B8 Libraries
4 02D - - Forest Library
4 | Shrubs = & 2D .
thumbnail Pl Shrubs
, thumbnails o Trees
4 | Trees = & 3D
. thumbnails Pl Flowers&igrass
4 130 P Stones
4 | Flowers8ugrass = w Free Models
thumbnails Pl HQPlants Free
= W% Presets
4
| Stones _ I W Metwork path
| thumbnails B User's Libraries
4 . Free Models

4 | HJPlants Free

The same directory showin in Windows Explorer and the Tree Navigator
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To create a new library:

When you create a library Forest Pack creates a new folder that includes an XML file and sub
folders for thumbnails. This and any other sub folders found in the library location will not be
displayed. This allows you to add additional directories for models, maps and materials used by
the library without them cluttering up the tree navigator.

1. In the tree navigator, right click on the folder where you would like to save your new library
and select Create Library
2. The library name will be highlighted, enter a title and press return

3. If you need to rename your library at a later date, simply right click on it and select Rename

To delete a library or folder

1. To delete a folder or library, simply right click and select Delete.

To add a new 3D object to a library

3D geometry can be added to any library saved in a user location (represented in the tree
navigator as a green folder). ltems are stored in .max files located anywhere on your computer or
network. However sharing is simplified if the files and any material libraries and bitmaps use
relative paths and are located in the library folder. If images with the same name as the object
are placed in the thumbnails folder, these will be used automatically.

To add a new 3d object:

1. From the navigator on the left, select a user's library.

2. Right click in the browser and select Create Iltem>3d Object

Use item(s)

Properties...
Delete

Create Item r Billboard
Irnport Billboards... 30 Object
Import Objects...

3. A new blank 3d item will be created in the item browser. To edit, right click on the item and

select Properties...
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4. Fill in the Taxonomy values, note that the common name is the text displayed by default in
the library browser though this can be toggled to display the Latin name. Other values can
be left blank if not required

Item settings - 3D Tree ohject @

Thumbnail

Cormmon Name

Family

Description

30 Model

Max File

Override Material

5. Click on the folder item next to the Max File field to select the .max scene file that contains
the new object

6. A list will open containing the objects in the scene, pick the item you wish to add to the
library.

@® Adding grouped content

If an item is grouped instead of a single object its elements can automatically attached
into one mesh upon import. To do this, when selecting your the item from the objects
list, simply select select the group name containing the object's elements.

1. If the object had a material applied this will be also be used in Forest Pack. It is also
possible to override the material from an external material library. In order to do this enable
the Override Material tick box.

2. Select the material library by clicking the folder icon next to the Mat. Library field. Find the
library and click Open

3. Next click the Select Material button, this brings up a list of the contents of the material
library. Highlight the material to be used and clickOK.
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Add a thumbnail by clicking the image file button below the thumbnail preview window.
Select an image file and click OK.

Click OK to accept the changes

Save the library by going to File>Save or selecting E from the top toolbar.

To create a new preset

Creating a new preset is the same as creating a new 3d object, the only difference being that you

select a pre-made Forest object in an external file instead of a mesh.

1.

10.

11.
12.

First prepare .max files, these will contain a separate Forest object for each preset.
Configure the Forest object's parameters as you would normally including geometry,
distribution, transforms, materials, diversity etc.

Save the max file to your Forest library folder, see below for more information on file
structures.

Open the library browser and from the navigator on the left, select a user library.
Right click in the items grid and select Create Item>3d Object

A new blank Preset will be created in the item browser. To edit, right click on the item and
select Properties...

Fill in the Taxonomy values if required

Click on the folder icon next to the Max File field to select the .max scene file that contains
the preset (created in step 1).

A list will open containing the objects in the scene, pick a Forest object that you wish to
use as a preset. A single max file can contain multiple objects, geometry and presets that
be combined in a single external file without problems.

Add a thumbnail by clicking the image file button below the thumbnail preview window.
Select an image file and click OK.

Click OK to accept the changes

Save the library by going to File>Save... or selecting E from the top toolbar.

To use the preset, select in the same way as though it were a 3d object. See the Library
Browser reference for more information.

To add a new billboard object to a library

2D billboards can easily be added to a user's library. These are loaded from a material library file

that can be saved anywhere on the local machine or network though for ease of sharing it is

common to move the files to the library folder and use relative paths.
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1. From the navigator on the left, select the library you wish to add a new object too.
2. Right click in the browser and select Create Item>Billboard

Llse item(s)

Properties...

Delete

Create Item Billboard
Import Billboards... 3D Object
Import Objects...

3. A new blank billboard item will be created, to edit it right click on the item and select

Properties...
4. As above, fill in the Taxonomy values.

5. Choose the material library by clicking on the folder icon to the right of the Material Library
field, select the library and then Open.
30 Model

Geometry One Flane -

6. Choose the material from the library by clicking on the Select Material button to bring up a
list of the contents, select a material and click OK.
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5| Select Material

Material

i@ abies_alba

@ zbies_albal

@ zbies_albaz

i Acer Rubrum

@ acer_pseudoplatanus
@ aesculus_hipocastanum

Class

Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3

@ Agave Americana

Forest Material 3

allanthus_altissima
i@ Albizia lophanta
P Aracucaria Heretophylla
@arbutus_unedo
i@ Areca
@ hreca 2
i Areca Lutescens

Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3
Forest Material 3

1|
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7. Add a thumbnail by clicking the image file button below the thumbnail preview window.

Select an image file and click OK.

8. Set a Default Height and Width from the Dimensions settings. To retain the proportions of

the image ensure Keep Aspect Ratio is turned on.

Dimensions

Width 3.539m

Height 4.517m

Center Offset 44

‘eep Aspect Ratio

-0, 121m

9. The center point for the rotation, scale and position can be adjusted using the Center

Offset and ZOffset attributes, represented as a percentage. A dashed line on the

thumbnail illustrates the effect of these settings. Typically the lines should intersect at the

base of a plant's trunk or stem.
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10. Click OK to finish and save the library by going to File>Save Library or pressing F2

To adding multiple 3D objects to a library

The library editor can speed up the creation of libraries by loading multiple objects from a single

scene file

To automatically create thumbnails, preview images that share the same name as the
scene objects should be moved to the thumbnails folder.

1. Open the Library Browser and use the tree navigator to locate the library you wish to add

items to.
2. Right click anywhere in the items grid and select Import Objects...

3. An Import From Scene window will open, select the .max file containing the objects by
clicking on the ellipsis (...), locating the files and clicking Open.

4. You will now see a list of all the objects in the scene. Select the items you wish to add to
the library. Use control and shift to select multiple objects in the usual way.
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s

5 | Import from scene

From Scene

ock001
Focko02

Rock004
Rock0d5

All Mone  Inwvert

Impaort

5. Click import. If bitmaps are located in the thumnbnails folder with the same name as the
items being loaded, these will be used as previews in the item browser.

6. If necessary edit the objects as described above.

Adding Multiple Billboards to the Library

The library editor can greatly speed up the creation of libraries by loading multiple billboards
contained within a single material (.mat) file. When creating libraries using this process
thumbnails can be generated automatically and materials can remain in the original location or
be consolidated into a single material file in the library folder.

Prerequisites:

® Asingle .mat file containing multiple billboard materials.

To add multiple billboards:

1. Open the Library Browser and use the tree navigator to locate the library you wish to add
items to.

2. Right click anywhere in the items grid and select Import Billboards...

Version 18
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3. The Material Importer will open. Select a material library by clicking on the ellipsis under
the Source section. Locate a material library and click open. Highlight the billboards you
wish to import.

' Material Importer
Source

Mat. Library

abies_alba (Forest Material)

abies_alba1 (Forest Material)
abies_alba? (Forest Material)

Acer Rubrum (Forest Material)
acer_pseudoplatanus (Forest Material)
aesculus_hipocastanum (Forest Material)
Agave Americana (Forest Material)

ailanthus_altissima (Forest Material)
Albizia lophanta (Forest Material)
Aracucaria Heretophylla (Forest Material)

arbutus_unedo (] st Material)
Areca (Forest Material)

Areca 2 (Forest Material)

All Mone  Inwvert

Catalog Location

v Create items in Forest Catalog

Import

4. Under the Catalog Location section tick the desired options:

Create Items in Forest Catalog adds the selected materials as billboards to the active

library

Create Thumbnail Images automatically generates thumbnails from the diffuse maps of
the selected materials

Create Material Library consolidates the selected materials into a single material library
located in the library folder. There is also an option to automatically convert them to Forest
Materials.

The default settings are generally OK.

5. Click Import and the materials will be added to the library.
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To add a macro to assign a material according to the active renderer

When creating libraries it is possible to use macros to add variables to an item's property fields.

This is very useful for creating flexible libraries that can dynamically respond to individual

installations or changeable 3DS Max settings. One common usage is the creation of library items

that automatically load appropriate materials based on the active renderer.

® [tems are created in the usual way but materials are taken from a separate
material library. In this example we assume three libraries, one for each of the
three supported renderers: Mental Ray, V-Ray, and scanline.

® Each material library's name should have two sections, one part that will be
identical for all three files and a second part that matches the variable names
assigned by Forest Pack's macro. [libraryName][macroValue].mat

® Forest Pack uses "mental”, "vray", and "standard" as values for the renderer
macro. The following three file nhames demonstrate appropriate file names.
MaterialLibraryName-mental.mat
MaterialLibraryName-vray.mat
MaterialLibraryName-standard.mat

® The actual materials contained in each library should have identical names
irrespective of the render. This allows you to dynamically switch between
materials by automatically loading a different library for each renderer.

Auto-loading a material library by renderer:

1.

Either create a new object as described above, or right click and select Properties to edit
an existing item.

Turn on Override Material, this allows you to use a separate material library to texture the
object. In this example it will automatically select a different material library according to
the current renderer.

In the Max File field type the parts of your material library name that is common to all files.
In the examples given above you would type MaterialLibraryName-.mat

Position the cursor where you want to add the renderer variable, in this case it would after
MaterialLibraryName- and before .mat

Click on Macros... and select hdfreerenderer from the subsequent list. Click OK to add the
variable to the filename. The material filename should now read MaterialLibraryName-$(
HDFREERENDERER).mat.
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v Override Material

Mat. Library | MaterialLibraryiam IFREEREMDERER,

Material MaterialMame -

6. Select an appropriate material by clicking the select material button and picking one from
the list. If the materials are identically named in each library, this macro will change the
material depending on the currently selected renderer.

20.3 Interface

Library Browser Preferences

To access the Library Browsers go to File>Preferences or click from the toolbar

es Z\Another Library

uments 'y ibranes 2

Name Description

Use scene material
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Name

Replace material
from library

Ask user

Merge into scene

XRef to library

Add...

Modify...

Delete

Evaluate

Forest Pack Documentation

Description

When selected in the event of a a duplicate material the version already
in the scene will be used

When selected in the event of a a duplicate material the version in the
library will be used

When selected in the event of a a duplicate material the which of the two
options above should be used

When adding objects the geometry will be merged into the scene.

When adding objects the geometry remains in a external file and is XRef
is used to add to the scene

Adds a new library location.

Modifies the location of an existing library.

Deletes a library location.

Shows the currect values for all macros.

Folder and Library Addition

Use the context menu accessible by right clicking in the tree navigator to create new sub folders

and libraries, and reorganise your directory using the mouse to drag and drop folders and

libraries.

Commands available in the tree navigator context menu :

Name

Open in Shell

Create Library

Create Folder

Version 18

Description

Opens the file location of the library in Windows Explorer.

Creates a folder with and a new "index.xml" file.

Creates an empty folder on the disk.
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Name Description

Rename Renames a Folder or Library.

Delete Deletes a Folder or Library with all its contents. Use with caution !
ltem Addition

To access the commands to edit a library's content, right click anywhere in the item grid. Note
that changes are only stored in the system memory until the library is saved to disk.

Commands available in the item context menu :

Use itemis)

Properties...

Delete [é

Create Fem L

1r11|:|:|r1 Billboards...

Import Objects...
Name Description
Use Item(s) Adds the selected item to Forest's geometry list..
Properties Shows the ltem Settings dialog box.
Delete Delete the selected item.
Create Iltem Creates either a billboard or 3d object

Import Materials Loads multiple billboads from a .mat material library Material Importer.

Import Objects Loads multiple 3d objects from a .max scene file Object Importer.

ltem Settings, Billboards

This window is used to set the properties for a billboard item. The Forest plugin uses this settings
to construct the plant object, most of them match properties in the plugin Geometry panel.
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gem settings - Billboan ! :I

— Thurmbnail

acer_opalus.jpg
252%300 pixels

acer_opalus.jpg Center Offset |58 ﬂ% Z0ffset ||:|,|:| ﬂ

— Taxonomy

Scentific Mame  Acer Opalus
Common Mame  Maple
Family Sapindaceae

Description

— 30 Model

Geometry I One Plane -

Material Library  C:\Program Files (x86)\[too Software\Forest Pack | |

Material Name  acer_opalus| bt

—Dimensions
Width [5,2 = [~ Keep Aspect Ratio
Height [10,0 =

Macros... O, ‘ Cancel |

Settings available for items :

Name

Scientific name

Common name

Family

Description

Geometry

Material library

Version 18

Description

Latin plant name.

Common plant name.

Botanical family of plant.

Textual description about the plant.

3D Geometry applied to the plant when is generated. Choose one of the
general Forest geometry templates.

3DS Material library for material.
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Name
Description

Material name Name of the material to apply. Choose one of the materials in the selected
material library.

Width Width of the tree object in world units.

Height Height of the tree object in world units.

Keep aspect ratio Keep the width/height of the object synchronized with map aspect ratio.

Center Offset Center of rotation for the object in % of width.

ZOffset Elevation offset from the floor level.

Thumbnail Preview image of object, represented with the same aspect ratio as real
object.

Thumbnail Press this button to change the thumbnail image.

Selector button

ltem Settings, 3D Objects

This window is used to set the properties for a 3d object item. The Forest plugin uses this
settings to construct the plant object, most of them match properties in the plugin Geometry
panel.
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setti - 3D Obje
iem setings - 30 O

ot Peplrsh_pos_treca_oan O1ox | L |
wewor |l

r

Settings available for items :

Name Description

Scientific name Latin plant name.

Common name Common plant name.

Family Botanical family of plant.

Description Textual description about the plant.

Max File The location of the scene file contatining the item geometry

Object The name of the object in the scene file.

Override material When on the object uses a material from a separate material library.
Mat. Library The location of the material library
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Name Description

Material The name of the material to be used if override is on.

Thumbnail Preview image of object, represented with the same aspect ratio as
real object.

Thumbnail Selector Press this button to change the thumbnail image.

button

The settings are similar as for billboards, however instead loading a material we supply a 3dsmax
scene with a object name. Optionally is possible to set a material override. The loading process
can be done merging or XREF the object into our scene.

Material Importer

If you have a 3DS material library with tree materials and textures, you can import them directly
into a Forest Library as billboards using this window. Forest and Planes Materials are recognized
in the process and their properties (such as plane size or offsets) are copied to the new items.

— Catalog Location

Mat. Library C:'Program Files (x86)\too J J¢ Create items in Forest Catalog

i@ acer_opalus (Forest Material 3) - uﬂ:,mﬂ? FrEle

acer_opalus? (Forest Material 3)
allamanda_cathartica {Forest Material 3)
berberis_julianae (Forest Material 3) ¥ Create thumbnails images
betula_pendula {Forest Material 3) \Wser's Libraries My PlantsNew
betula_populifolia (Forest Material 3) Library\thumbnails\<name:-.jpg
chamaerops_humilis (Forest Material 3)
W citrus_sinensis (Forest Material 3) IV Create material ibrary
i@ grass (Forest Material 3)
i@ juniperus_communis (Forest Material 3)
i@ lzurus_nobilis (Forest Material 3) ¥ Create as Forest Materials
i nyssa_sylvatica (Forest Material 3)

Wphoneix dactiifera (Forest Material 3) 7
1 | i [ ¥

To library  Mew Library.mat

All |None|lrwa't|
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Name
Mat. Library

Create items in
Forest Catalog

Create thumbnail
images

Create material
library

Create as Forest
Materials

Object Importer

Forest Pack Documentation

Description

Used to select a material library to import billboard materials from.

When activated adds the selected materials to the current library.

When activated automatically generates thumbnail images and saves
them to the thumbnails folder.

When activated adds and consolidates the selected materials to a new
material library.

Saves new billboards as Forest Materials.

As for materials, you can import a whole directory of 3DS Max objects into a library automatically.

~Select Objects

@ Cameradl
*_Alexander palm 03
i@ Camerall
° Alexander palm 02
& Camerall
°_ Alexander palm 01
i@ Cameraldl

From Scene  D:‘hgplantsthg_palms_1

°  Alexander palm 04 alexander_palm_04.max

alexander_palm_04.max
alexander_palm_03.max
alexander_palm_03.max
alexander_palm_02.max
alexander_palm_02.max
alexander_palm_01.max
alexander_palm_01.max
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Name

From Scene
Object list
All

None

Invert

File Structure

— |

— &

ALK

Description

Used to select a Max scene to import geometry.

Lists all the objects found in the selected scene.

Selects all objects.

Deselects all objects.

Inverts the current selection.

Y

%

Forest Pack Documentation

4 A library is a special folder on the disk which contains an
index.xml file, where the items are listed. This file points to the files necesary to define a library
item. The browser stops to scan directories when an index.xml file is found, so a library folder
can't contain other libraries and all subfolders are hidden in the interface, this permits to you to

organize the data in several subfolders.

Each library item points to a single template object in a .max file or to a material in a .mat file.

Each time you select a library item, all settings in the template object are loaded and applied to

the current Forest object. You can group several objects in a single file, or have separate files for
each one. You can also use macro substituion (see section below) to use conditions or complex

structures.
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Each library item also has an associated image file, typically stored in the thumbnails folder. This
image is used to show the image preview in the library and you should have one image for each
library item. If you name the files using the same name of the object, the image is automatically
selected in the editor.

Additionally, you can have materials libraries to override the object's default material. This way
you can have several library items with the same geometric base, but with different materials and
textures.

Macros

In some fields, such as filenames and object or material names, you can use macro sustituions to
add more flexibility to your library structures. These macros represent the library root location,
current folder, or 3dsmax state values. The macros are instanced using the $(NAME) format.

To open the Insert Macro window, press the Macros... button in the properties window, select a
macro and click OK, the selected macro will be inserted in the current field of the properties.

o o

Insert Macro @

[ibfullpath C:%Proagram Files |5 Iboo SaftwarehB alClonehlibh
libname Pavernent

libparentname Civil Engineering

libroatpath C:%Proagram Filez [#86]4 oo SaftwarehR alClanehlibh,
TNARVETZION 9

renderer gtandard

4 1 3

k. Cancel
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21 Forest Tools

21.1 Overview

Forest Tools is a utility that allows you to convert a forest object to individual instanced geometry.
This can be used when you need to share a file with someone who does not have the forest
plugin, use a renderer that does not natively support Forest Pack, or export the scene to another
program.

21.2 Procedures

To add Forest Tools to the Utilities panel

1. From the Command Panel click n to open the Utilities Panel.

2. Click to open the Configure Button Sets menu.

3. From the Utilities list on the left, drag Itoo Software > Forest Tools to an empty button slot
on the right. If necessary increase the number of buttons using the Total Buttons spinner.

( Configure Button Sets @

-

tilities:

Animation Store
Animation Store
M I_IF:.E:E:'

I EEE O Total Buttons: g
roduct:
ama Exporter Utilities:

3dzmax

ne Effect Loader

Perspective Match
Reset XForm
Color Clipboard
Measure
MAXScript

1 Glue
Itoo Software
Forest Tools
Glue
RailClone Tools

Forest Tools
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4. Click OK.

To create instances from a Forest Pack object

1. Select the Forest object to instantiate.
2. Open Forest Tools from the Utilities Panel.

3. In the objects group activate Move to layer and enter a name for the new layer.

® It is also possible to add instances to the current layer or add them to a new
group, however creating a new layer is recommended for more efficient scene
management.

4. Optionally select the Freeze checkbox to freeze the layer and select the Boxes checkbox
speed up viewport performance by displaying instances as boxes.

5. Click Instantiate.

To delete existing instances

1. Select a Forest Object that has previously been used to create instances.
2. Open Forest Tools from the Utilities Panel.

3. From the Objects group, click Delete.

To update instances

1. Select the Forest object to update.
2. Open Forest Tools from the Utilities Panel.

3. If there are instances already in the scene that you need to replace, from the Objects
group click on the Auto delete old items checkbox. This will delete any existing instances
before creating new ones. Alternatively to remove them immediately click on Delete.

4. If the forest object is disabled, click Enable and make the necessary changes. If the Forest
object is disabled and you do not need to enable it to make the changes, ensure that the
Enable before start checkbox is selected.

5. To automatically disable the Forest object after instances have been created, select the
Disable at end checkbox.

6. Click Instantiate.
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To optimise materials for the active renderer

1. Open Forest Tools from the Utilities Panel.

2. Click Optimize in the Material Optimizer section. The material optimizer tool will open.

B Material Optimizer ==
Render Engine Apply to

Scanline + B Selection -

v Convert Standard Materials to VRay/Me

-

Diffuse Maps

v Apply Forest Color  RGE Level 1.0

v Exdude materials using these names:

[Trunk]

Optimize

3. From the Render Engine drop down list, pick the current render engine (this should be
automatic).

4. From the Apply to drop down list, select whether to run the optimizer on the current
Selection or the Material Library.

5. For most situations the default settings are suitable. To exclude specific diffuse maps from
being optimized, enter their names, separated by commas, in the Exclude materials using
these names text box.

6. Click Optimize.

To export XML data

1. Select a Forest Pack object

Version 18



Forest Pack Documentation

2. Go to the Command Panel > Utilities and click Forest Tools.

Forestd01
|tilities
Mare... Sets Et

Asset Browser

Perspective Match nera Tracker
nnel Info
Collapse ean MultiMaterial
M Server Control
Manager
i Ambient
&k
Motion Capture orest Tools

Color Clipboard

Measure

IFL Manager
Insta Duplicate Maps
Level of Detail

Flight Studio {c) Lighting Data Ex

F'ar.u:nrarna Exporter
olygon Counter

rid Units
ectaor

3. Click Export Data.
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Instantiat

Ohijects

Individual objects

Create group
* Move to layer
forest_instances
¥ Freeze » Bowxes
v Auto delete old items
=
Geometry List
v Disable at end

v Enable before start

Enable

orest Exporter

Export Data

Material Optimizer

Optimize

4. From the Forest Data Exporter utility set a save path by clicking .
5. Enable the IDs of the channels you want to export.

6. Click Export.
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index
geomID

probability

==

localPosition
ed
scale
rotation
localmM
finalmM
tintCalar
timtult
mirror

light
billbe

surfiMormal
surfDirection

B Forest Data Exporter

Si

Probahil

Transformation Matrix in local coordinat

Transformation Matrix in world coordina

ctor from Ttem to Look-At target
ctor from Item to Light
ctor parallel to billboard [X,Y

ro based)
, 4800 ticks per second)
Maormal to 5
Direction vector

Barycentric coordinates of face hit on Surface

3 Export

Cancel
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21.3 Interface

Forest Tools

to stand:

Instantiate

Objects

Individual objects

v Auto delete old items
Delet
Geometry List
Disable at end
Enable before start

Enable

Forest Exporter

Export Data

Iptimizer

Optimize

Instantiate

Converts the geometry items of the selected Forest object to instances.

Objects

Individual objects

When enabled, creates instances as stand-alone objects.
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Create group

When enabled, adds all instances to a new groups.

0 3DS may be very slow handling a huge number of objects in a group, most of times is
better to put them as non grouped objects in a separate layer.

Move to layer
When enabled, creates a new layer and moves the instances to it. Use with the following options:
® Freeze. Freezes the new layar

® Boxes. Displays new instances as boxes, useful for improving viewport performance with
large numbers of instances or complex meshes.

Auto delete old items

When enabled, old instances are removed before creating new objects.

Delete

Removes instances manually. This only works if the instances and the Forest object and the have
not been renamed .

Geometry List

Disable at end

When the instances are created, we don't need anymore the trees created by the Forest object
in the scene. To hide them, Forest Tools set the elements of the Geometry List to "Disabled". So,
if you would like to recover the Forest mesh, set the Geometry back to "Custom Object". If this
checkbox is disabled, Forest Tools doesn't modify the Geometry List.

Enable before start

Sets the Geometry to "Custom Mesh" automatically before creating the instanced objects.
Enable

Used to set the "Custom Mesh" mode in the Geometry List manually (of the selected Forest
object).
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Forest Exporter

Export Data. Click this button to open the XML exporter tool. Using this menu you can export
most of the internal options in a standardised format for use in advanced pipelines and to aid
interoperability between software.

7 | Forest Data Exporter

Destination File | C:

Description

index
geomlID
geomType

Index

(zero based)
Type of object in Geometry List (0:dis

abled, 1:template, 2:custom)

Caolor ID

5
probability
material
position
localPosition

3
rotation
localmm
finalM
tintColor
tintMult
mirreor
ookATY
ig

. Click to set the save path for the XML file.

Enables the data channels to be exported. By default all are selected.

Maone

ID
“ Click to select all IDs.

Click to deselect all IDs.

Click to save the XML data to disk.
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Click to close the XML export utility.

Material Optimizer

Runs the Material Optimizer for the selected Forest objects. See Materials for more information
about this tool.
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22 Forest Color

22.1 Overview

This 2D texture map is used to add color variation to the Forest items. It works similar to Forest
Material, but it is a 2D map instead a material.Usually, Forest Material is used for billboards and
Forest Color for 3D objects

22.2 Interface

Map #22 ( Forest Color )

Map #22

Maps
Default Get ID from
MNone Ttem -

Override Variation
Item Element

Random Strength

Blending

Mode Color

About
arest IZ-|:|||:||' g3

Version 18



Forest Pack Documentation

Maps

You can define up to 10 texture maps to Forest Color, that are assigned randomly on two
selectable modes: by 'ltem' or by 'Element":

® The Iltems are the base objects assigned in the Geometry List, and scattered by Forest
creating the main distribution, for example the trees on a nature scene.

® The Elements are the mesh pieces that define an ltem, as the leaves or the branches of an
individual tree. Note that the Elements are not the faces of a mesh, but an upper hierarchy.
Internally, Forest Color consideres an Element as each group of adjacent faces of a mesh
that share the same material ID.

The "Default" map is used as default texture when the other 10 map slots are disabled.

To use Map and Tint by Element, you must use VRay or Mental Ray and standard
meshes as Custom Objects, other type of objects as proxies are not supported.

Tint

By default Forest Color applies the Color Tint defined in the Material rollout of Forest object to
the resulting map. This includes Color Range, Min and Max values and the other parameters (see
Forest->Material for details). You can override these values on each instance of Forest Color,
turning on the "Override" checkbox.

In this rollout you can find some additional parameters that define how the Color Tint is applied
to the map:

Variation

Defines the amount of Color Tint applied by Iltem or by Element (see above the definition of these
concepts), using a weight scale from 0% (ltem) to 100% (Element). See the following images for
some examples of use.

"Get color from map->As Texture on Surface" works only at Iltem level, it's not
compatible with tint by Element.
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Blending Mode

Use the drop-down list to choose how the Color Tint is mixed with the map. The following modes
are available: Normal, Color, Additive, Average and Multiply. These modes work in the same way
that the Composite map included in Max.

Sample Images
A Forest scene using different values of Color Tint. Note how changes the Variation weight from trees (Item), to

leaves (Element)

Original Scene
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This scene uses a clump of grass as custom object, using Tint by Element to apply a different colour to each

blade of grass
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23 Forest Material

23.1 Overview

This material plugin is used for some advanced features of Forest, as Random Tinting or Fake
Shadows.

It is mainly used on billboards, if you want to add color variation on 3D objects, we suggest to use
Forest Color, that is a 2D texture map.

It works as a enveloping layer over the base material used on the object, and modifying the result
of this (applying the tint, or hidding the shadow planes).

You can use any material as base (from Standard Mat. to VRayMtl), but for billboard trees we
suggest to use a Standard Material (specially with Mental Ray), because some features only work
with it.

0 On Multi-sub materials, always use "Forest Material" as a sub-material, in this way:

& tree [ Multi/Sub-Object | Ftiee fat [ Forest Material 3]
ﬂ [1]: trunk [ Forest Matenal 3 _ tree [ Mull/Su [ect |

: b4 MBasze: bunk_basemat | Standard | : at [ Standard |
ﬂ [£]: leaves [ Forest Matenal 3 ] : 3 | [ Standard |

Yes
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23.2 Interface

Material #63 ( Forest Material')

Material #63
Parameters

MNone

MNone

Horizontal Mone

Cwverride Tint Forest Shader

=] — v Enabled
= to

(Mental Ray only)

About
T [

Shadow Textures

When billboard trees are used, Forest has native support of shadows using our XShadow plugin
or raytraced lights. For each tree, two opacity textures are used: vertical and horizontal.

By default, XShadow searches automatically in the the material tree to find the vertical texture (
Standard, Multi Sub-Object and "Forest Material" only) but this can be defined explicitly in Planes
Material using this parameter. The horizontal texture must always be assigned here.

Raytraced shadows and Mental Ray need "Forest material" to work, because this plugin does the
job of hiding or rendering the shadow / texture for each plane. Be sure that the material applied
to the Forest object uses the "Forest Material" plugin as a base.

Override Tint

By default, Forest uses the Random Tint values defined in Forest->Material rollout for all tree
samples used in the object, but those parameters may be overrided here for each material.

This feature is specially useful for mesh objects that use a Multi-sub material (as mat.ID 1 for trunk,
mat.ID 2 for leaves), allowing to apply different tint for leaves and trunk (or disable tinting setting
Min/Max values to 0).
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’ Randaorm waluss
Az texure on Swuisce

Handom&d;‘screte colors oft custom materials
Forest Material + Ovemide Tint + Gradient Ramp

Forest Shader (Mental Ray only)

Forest includes a custom shader that enhances the rendering of billboard trees. It fixes some
problems inherent to planar trees, as the illumination or the slow transparency computing in
raytracing modes. Although the shader must work in all modes, if you are experiencing some
material issue or get unexpected results, you can disable it from here.

Forest Shader works only if a "Standard Material" is used as base material. This is specially
important for billboard trees, for Custom Objects you can use other type of materials if you like.

The behaviour of Forest Shader is defined by some parameters of the Forest object as well. See
Forest reference->Material for details.
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24 X Shadow

24.1 Overview

Shadow is a plugin to create realistic shadows for billboard trees.

@ This plugin is used only with Scanline renderer, it's not compatible and there is not any
benefit for using with Mental Ray or VRay.

24.2 Interface

When you create trees using planar geometry, they cast ugly rectangular shadows. You must use

Raytrace Shadows to get a good projection, but it's very slow. This plugin builds a perfect
shadow for Forest objects in all conditions. It works as a Shadow Map and there are no problems
at render time:

Camerall
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This is a shadow plugin, and must be chosen in the shadow parameters of each light. At present,

it only works with directional lights (with spots and omnis it doesn't create any shadows for trees):

Shadows
I Onl Use Global Settings

| %S hadaw 3 |

Exclude. .. |

|- Parameters

#Shadow 3.0

[z] 2008 Ikoo Software
i iboozoft, com
infal@itoosaft com

— Shadow Image
" Dpagque
% From opaciby material
£ Cuztam

MHone

[~ Disable texture cache
¥ Frevent Seli-Shadow

Bias [T.0 2| Siee[512 2]
Sample Range [40 2

v Abzolute Map Bias

Shadow image

XShadow uses two opacity textures to build the shadow: one vertical and the other horizontal.

By default, the plugin searches automatically in the material tree to find the vertical texture (

Standard, Multi Sub-Object and "Forest Material" only). The horizontal texture must be defined in

a "Forest Material" (see Forest Material reference for details).

These parameters define the vertical texture in the XShadow plugin:

Opaque

Builds the rectangular original shadow (from Forest mesh)

Opacity material

Use the opacity texture applied for each tree as shadow.

Custom

Lets you choose a custom texture map.
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Disable texture cache

The plugin builds an optimized cache buffer to increase the render speed. In the most scenes, it
works well, but if you get some "blocky" shadows or other visual problems, use this option to
disable the cache (you can use it also to compare the render time in both states).

The other parameters works the same as standard shadow maps, and for non Forest objects the
shadows obtained are the same.

Prevent Self-Shadow

Enable this checkbox to avoid that a tree cast the shadow over itself.

Optimizing XShadow

To get the best results with XShadow, we must understand how shadow maps work:

The "size" parameter in XShadow defines that Max will use a bitmap of that number of pixels to
draw the shadows on it. But this map is applied ONLY to the light's hotspot area. So, to get better

shadows you must close the hotspot to surround only the objects to shadow. This is a sample of
a well adjusted hotspot for XShadow (seen from a light viewport):

Light hotspot adjusted to object

Using a well adjusted hotspot, a shadow map of 4000 pixels should be enough for most scenes.
For very large terrains, we suggest you use different cameras and lights, adjusting them
individually to shadow only the trees visible in each view or use raytraced shadows.

XShadow needs large buffers of memory to work, and if the scene is complex, Windows might
not have enough free memory for it. If this occurs, XShadow stops and displays an error.
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And sometimes adding more memory to the system may not solve the problem, especially if you
are using a 32 bit version of Windows, because there are other limits due to the 32 bit
architecture, for instance memory fragmentation is an issue (when there is free memory that
cannot be allocated in a contiguous space).

This is not only an XShadow problem. When Max uses its standard shadow map plugin, and there
is not enough memory for the buffers, it doesn't build the shadows but doesn't show any error!
This may be annoying for the user, who doesn't know why shadows are not working. In XShadow
, we prefer to display a warning message. In order to fix the problem, here are some possible
solutions:

® [f you have at least 4 GB of memory, always use Windows 64 and 3D Studio 64 bit
versions.

® Don't use a higher value than 4000 for the "size" parameter in XShadow. The memory
needed grows exponentially with this value. Also, optimize the shadow hotspot of the light
(see previous section in this FAQ).

® |In XShadow, enable the checkbox "Disable exclusivity buffer" to reduce memory used for
XShadow by half. When this option is enabled, the plugin doesn't check to see if each tree
shadows itself... but this effect is not noticeable in most of scenes.

® Use raytraced shadows, which are natively supported by Forest.

® XShadow works only with directional lights (targeted or free).

® If you use other lights in scene with shadow enabled (without using XShadow),
they cast rectangular shadows for Forest objects... the Forest mesh always exists,
of course.

® When using Forest Pro and custom meshes, XShadow builds the standard
shadow of an object, except if you enable the checkbox "Cast opacity mask for
Custom Object" in Forest's Shadows rollout.
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25 Rendering Best Practice

Forest Pack includes native geometric shaders for the renderers listed below, making it possible
to render scenes with millions of high poly trees, meshes and proxies:

® Mental Ray

® V-Ray

® V-Ray RT

® Maxwell Render
® Octane Render
® Arion Render

® Corona Renderer
® Thea Render

® Moskito Render

Usually these techniques push the rendering engine to its limits. In the following notes, we
include technical information that can help you to optimize your renderings, and avoid some
problems.

25.1 Common Tips

- Minimize the use of opacity maps in your plants. Raytracers are slow computing transparencies,
when possible use mesh leaves instead masked textures, although number of polygons be
higher. If you need to use opacities, disabling the filter map may help to speed up the render.

- You can use the Material Optimizer included with Forest Pack, to converts the materials to VRay
/Mental Ray and tune up the texture maps. A good example of use are the XFrog Plants libraries.

- When possible, use Max 64 bit. The 32 bit versions are very limited, and you may get memory
errors when rendering complex scenes.

- Don't mix 32 bit and 64 bit environments for rendering, you would get unexpected results.
Because the different numeric precision of both architectures, some problems may appear as:
misaligned objects, color variation and others. Generally, it's not a good idea to mix 32 bit and 64
bit nodes in 3DS Max, to avoid issues as rendering flickering or glitches in procedural textures.

- XShadow is not compatible with Mental Ray and VRay. This plugin, based on Shadow maps,
was written for Scanline renderer but is obsolete with the new rendering engines. Instead it, use
raytraced shadows in Mental Ray or VRayShadow in VRay. If you use billboards, don't forget to
assign the main light in the Shadows rollout.

Version 18



Forest Pack Documentation

25.2 Mental Ray

- To get acceptable rendering times in large scenes, it's necessary to use BSP2 as raytrace

method. It is available only in Max 2009 or greater. For previous versions, or small-to-medium
size scenes, you can use BSP instead.

- Always disable "Scanline" checkbox (in "Rendering Algorithms" rollout), and we suggest to
enable "Use Placeholder Objects" (in "Translator Options"). These settings are specially
necessary when rendering complex scenes with large number of instances.

Note 1: The use of Placeholder objects is incompatible with the G-Buffer channel "Coverage".
This channel is used in the RPF format, for some Render Effects and by third-party plugins as "
PSD Manager" from Cebas. If the Placeholders are enabled, the channel is rendered as pure
black. Unfortunately, this is a Mental Ray limitation and there are not known workarounds for it.

Note 2: We also found that the Placeholder objects feature crashes with some types of proxy
elements used on Civil View (3DS Max Design), specifically the Street Lamps. Be care if you use
these elements in your scene.

- You can use assign billboards, meshes, mrProxies or any other object for your trees. In our
sample scenes, we have not found differences (in render time or memory used) between using
meshes or proxies, but we suggest that you make your own tests.

- Mental Ray versions before to Max 2010 was not fully stable using a high number of objects (
above 100.000 trees). Some errors would occur as crashes, "accessing unknown tag" messages,
etc. This problem has been solved in latest Max releases.

- Rendering times with more than 500.000 trees grows exponentially. This seems to be the limit
of Mental Ray handling large number of instances.
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| _ Tranzlator Ophions |
temony Options

|_|7 |1ze Placeholder Objects I kdemony Linnit; | [=a0] ﬂMB
[~ Use mertal ray Map Manager Conserve Memary

|- R endering Algorithrns |

— Scanline
[~ Enable
IT Uze Fazt B asterizer [Fapid Motion Elur]
Samplez per Bixel: |16 -

Shades per Fizel.  [20 | 2]

T he mindmar zamples and contrazt parameters, fram the
S ampling Euality rollout, are ignored when using Fast
Hazterizer.

— Fay Tracing
[¥ Enable
[T Use Autovolume

Raytrace Acceleration

pdethod: BSF2 b I

25.3 V-Ray

- V-Ray native shader requires Max 9 with VRay 1.50 SP3 or greater.

- To render high-poly objects or proxies, increase the Dynamic Memory Limit from the default
value to a percentage of your total RAM. The optimal value depends of the complexity of the
scene, but usually a minimum of 2000 or 3000 Mb. is required. In V-Ray 2.0 and later, you can
set this to O to remove any limit in that case, V-Ray will take as much memory as needed.

- You can use billboards, meshes, or V-Ray proxies in Forest. In our test scenes, we have found
that meshes usually render slightly faster than proxies.

Commar | W-Hay | |ndirect illurination | S ettingz | Render Elements |
i+ W-Ray: DMC S ampler li
i+ Y-Ray: Default dizplacemnent [i

] - W-Ray: System |
— Raycaster params — Render region divisioh——————————

b ax. tree depth: IED ﬂ = |E4 ﬂ L IHegi.;.n WwWH -
tir. leaf zi :I = T I =
- [ J o J Fieverse sequence |

Facedlevel coef. I‘I_EI = .
: — | Reqion sequence: ITrianguIatiDn -
Diyniamic memmary limit: |3EIEIEI ﬂMB
Drefault geametry: I”"*“t':' ,] Previaus render: ILInu:hanged -
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25.4 VRayRT / Maxwell Render / Octane / Arion / Thea
Render / Corona Renderer

Due to technical restrictions, support for these engines is limited, and the following features are
not available:

® Forest Color.
® Forest Material.

® Material->Random Tint.
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26 Forest Release Notes

Full release notes are online.
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27 Forest Pack Licensing Guide

27.1 Overview

Software License Management is available in two models, Stand-alone and Floating/Network

licenses. Under a stand-alone license, any given product is constrained to a certain host. A
license is needed for each computer that the software will be installed on. In floating license
mode, a pool of licenses is available on the server, for use in any computer on the network. You
only need to have licenses for the maximum number of simultaneous users expected, not for
each computer where the software will be installed.

Depending on the size of your business and expected use of the software, one of the two
models is usually preferred. In small sites with few computers, the Stand-alone licenses is fast
and easy to deploy, the licensing process is part of the software installation, leaving the software
ready to use in one step. For larger sites, the floating network licensing is preferred because it
provides more flexible use of licenses, you only pay for simultaneous users and not for nodes,
while the centralized management tool simplifies control of all your licenses.

Stand-alone License

The Stand-alone license ties a single software application to a single computer. This method of

licensing requires a machine's unique identifier (SID) to be incorporated in the license activation
process. After buying the product, an generic license code is sent to you, the license is installed
and activated. In the activation process the license is linked to the computer and can be used
only for that computer.

Floating Network Licenses

Network licenses (also known as floating licenses) allow multiple users to share a limited pool of

licenses in a local network. After installing the License Server on a server machine, the server will
handle requests for licenses from the users computers. If you have a team of 20 people and 10
licenses for a product, the entire team will share access to the 10 licenses, while no more than 10
people can use the software at the same time.

While Stand-alone licenses use a license file installed and activated for each computer, and can
be used only in that machine, the network licenses are installed and activated only one time in a
server. When a license request arrives, the server determines whether the proper license for a
requested product is available. If an appropriate license is present and not in use, the server will
allow access to the software.
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As the licenses are stored on a server, you cannot use the software if you are not connected to
the network. Although the server software does not require a powerful system, it is mandatory
that the computer hosting the license server be running and available while there are computers
using the licensed software.

27.2 License Activation

When you acquire a license from Itoo Software, a generic license code is sent to you. Before
using the software, this license must be linked to your hardware, this process is called activation.
You can activate the license during the software installation (only for Stand-alone mode), or from
the License Manager once the software is installed.

During the activation of a license, you can choose two different methods, Automatic or Manual.
With Automatic activation you must be connected to the Internet, the software will connect with
our activation server through a secure connection, and the activation codes will be sent and
installed automatically. No personal information is sent during the process.

If you experience difficulties with on-line activation, or the computer where you are using the
license does not have Internet access, you can use Manual activation instead. In this case, the
software gives to you the necessary codes and a link to our secure activation page. In this web
page, you enter the codes and the activation key is generated. Write or print out this code, and
provide it when the Activation Wizard runs, then the license will be activated and ready to use.

For security reasons, our activation server allows you to activate a license only a certain number
of times (5 by default). If you exhaust the maximum number of activations, please send us an
email at activate@itoosoft.com, we will increment the activation counter associated with your

license. In the authorization process, the server informs you of the number of activations
remaining.

In either case, if you have trouble during the activation, please contact us at activate@
itoosoft.com.

27.3 Network rendering licenses

Our commercial plugins require a license for each computer, to open or edit the scenes, but NOT
for network rendering nodes. The installation for slave nodes is much simpler, and does not
requiring licenses or activations.
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27.4 Floating/Network licenses

Introduction

Network licenses (also known as floating licenses) allow multiple users to share a limited pool of
licenses in a local network. After installing the License Server on the computer being used as a
server, the server will handle requests for licenses from users computers. If you have a team of
20 people and 10 licenses for a product, the entire team will share access to the 10 licenses,
while no more than 10 people can use the software at the same time.

While Stand-alone licenses use a license file installed and activated for each computer, and can
be used only in that machine, network licenses are installed and activated only one time on your
server. When a license request arrives, the server determines whether the proper license for a
requested product is available. If an appropriate license is present and not in use, the server will
allow access to the software.

As the licenses are stored on a server, you cannot use the software if you are not connected to
the network. Although the server software does not require a powerful system, it is mandatory
that the computer hosting the license server be running and available while there are computers
using the licensed software.

In order to deploy Network Licenses you must:

1. Install the License Server on the server computer.

2. Install and activate one or more Network Licenses on the server using the License
Manager.

3. Configure each client to retrieve the licenses from the license server.

License Server Installation
To be able to use network licenses, a computer in the network must be designated as the license
server. Once you have selected it:

1. First make sure that your have administrative rights on the target computer.

2. Download the License Server software from the links you received after purchasing the
software (in the registration email).

3. Run the setup program and follow the steps.

The License Server will be installed as a system service named "ltoo Software License Server". A
shortcut to the License Manager is also created on the start menu.
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License Manager

You must use this tool to manage the licenses of all products purchased. It's the same one used
to manage the Stand-alone licenses.

To use it, select the License Manager in the Itoo Software/ License Server group of the Start
menu. There are four tabs in this tool, two of them are only available if you have a license server
installed:

® Licenses: On this page the licenses are listed and managed

® Computers (only with License Server installed): Here you can see which computers are
connected and manage them.

® License Server: (only with License Server installed) On this page, the system administrator
controls the License Server. You can check the status of the service, start and stop it.

® About: Here you can find information version and contact information.

Licenses

When opened, the License Manager displays the installed licenses. You can retrieve license
details, check its status, activate it, or add new licenses as shown below:

& Itoo Software License Manager |‘Z] [E| [g|

E @’ Licenses :...l.t E.;:umputérs.'_._'@”License Server _ﬂ? ..-’-'-:I:unut__

| Mame Product Type S/ Activation Cietailz |

T vour Company Test Application Metwark, 1030409169 Active |
| ¥ %our Company Test Application Metwark, RARZEFI0EY  Mon Active |
@,"Yuur Company Other Application  Mode Locked 2015826561  Active
| X - : Eraken 0000000000 -

Add ..

Hardware | for this computer

BiGYELEHw-MEMOSSH-U THLLEUIYFY TFMEN

Licenses can appear in different states, depending on the type of license and its activation status:

* & Activated Stand-alone licenses: Shown in black text, these licenses are not used by

the License Server (see Stand-alone license).

® Tu Activated Network Licenses: Shown in blue text, these licenses are activated are
ready to be shared on the network.
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* 1. Un-activated licenses: Red text with an warning icon, theses licenses are valid but
have not yet been activated. You must activate them before using.

o X Broken licenses: Red text with an error icon . These licenses have corrupted data and
can't be used in any form. They must be reinstalled.

To obtain more information about a license, use the Details... button, here you can see the data
stored on it.

Installation of new network licenses

Unlike Stand-alone licenses, that are authorized for use only on a single workstation (the
computer on which its installed), a network license allows for concurrent usage for a specific
number of workstations. This number is shown in the license's details as "Licensed for x users".
For instance, if you purchase 5 network licenses, you won't receive 5 separate license codes,
you will only receive one code that once installed creates a license for 5 users in the License
Manager. Later, if you purchase licenses for 3 additional workstations, you will receive a new
license code for 3 users, that must be added in the License Manager.

When you acquire licenses from ltoo Software, in the e-mail you get the license code, as a block
of letters and numbers. To install it, use the "Add.." button on the Licenses tab. Copy and paste
the code in the window. Please be sure that you do not include any text other than the code itself

o Hew license

Pleaze, enter the license code you received from ltoo Software

Paste your
license code
here

[ Ok l ’ Cancel

If the entered code is valid, press Ok. The license is installed on your computer and ready to be
activated.

License activation
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The activation process is identical for Network as for Stand-alone licenses. The difference is that
the network licenses are activated and linked to the hardware of the License Server.

After an new license is installed, you'll be asked to start the activation wizard. You can activate
manually using the "Activate" button as well. Please, see the activation process in Stand-alone

licenses for instructions on how to do this.

Computers

In the "Computers" panel, you can see all clients that are connected to the server, what licenses
are being used and how long each computer has been connected.

& ltoo Software License Manager, |Z||E|E|

Huosthame P Up Time Product Refresh
iy
iy
]

Hardware |0 far thiz computer

EGYELEHW-MBMO5IH- THC2DUE-E DS UFAD

Connected

Each time that a workstation uses a network license, it connects to the License Server and starts
a lease of the license for a limited time period. Before that period expires (by default ten minutes)
, the license must be refreshed or the lease will be lost and the license can be requested by
another user.

Using the "Disconnect" button you can force the server to disconnect a computer before the
lease time expires. The typical use of this control is when a workstation has locked up, and it's
license is locked to that computer. In this case, you can unlock the license by manually forcing a
disconnection. If a workstation doesn't reply after the lease time period, it is disconnected
automatically by the server.

License Server

On the "License Server" page, you can check the status of the service, start and stop it. A
detailed log of the server activity is also available, to diagnose any problems.
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& Itoo Software License Manager g@

Server Control

Server iz running Stop Server

Wiews Log...

Server Information

Service YWerzion 1.02 iz running on TCRAJDP port 16720 Refresh
Loaded 2 Metwork Licenses

Hardware [ for this computer
AGEYELEH -MB MO0 IH-UTHC20UE-E FDSLIFAD Cloze

Connected

The top panel shows information about the windows service, whether it's installed correctly and if
the service is started. Using the "Start/Stop Server" button you can stop the service and restart it
at any time, please note that if you stop the service, all connected clients will lose their leased
licenses and will try to reconnect.

The bottom panels gives you more detailed information about the service, such as the server
version, TCP ports used and the total number of connected users. This data is updated each time
you enter this tab, or by clicking the "Refresh" button.

Configure Clients

A network license can be used from any computer that can connect to the License Server over
the network. The license server or network licenses should not be installed on the client
computer. To configure your software for using network licenses, please follow the procedure
below:

From the Start menu, search for the application group and select "Change License Mode". You
will get the license configuration window:
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@® Select License Type

Select your License Type.
Select what bype aof license will use Forest Pack Pro,

Please selectk the type of license wou will be using wikth Forest Pack Pro, Then
seleck Mext ko continue

Select License Type

() Mode-Lock Single User License

I purchased a single copy of the product For use in this computer,

{®) Metwork, Floating License

My organization purchased the product and rmy administrakor had
inskalled a License Server in the network,

< Back ” Mextk = l [ Cancel

In this window, you select with type of license the software will use. The first option uses a locally
installed Stand-alone license. Selecting the second option, the software will use network licenses
. You will be asked how to connect to the license server in this dialog box:

@ Configure the Network License

Configure Hetwork License. -
Select how ko connect to vour License Server,
¥ou have selected to run Foresk Pack Pro using licenses From a license server,
Flease select how connect to the server ;
Select Connection Method
(%) Search For a License Server automatly (Recommended),
) Enter License Server name ot IP Address:
Haosk: | | Part: |:|
Mote: If wou do not already have this information, please ask your syskem
administrator ar site coordinator abauk it
< Back ” Install l [ Cancel
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The first method is the recommended procedure, the client will search for an active server over
the local network using a broadcast query. The server will be located each time that a license is
needed by the software. If the server is accessed through a router, and the automatic method
doesn't work, you must use the manual configuration and enter the IP address used to retrieve
the license.

Please note: If you have installed multiple commercial Itoo Software products, each one has its
own license configuration. You can use one product with a Stand-alone license, and another with
a corporate network license. Please make sure that each product is configured to use its license
correctly.

Accessing the License Server through a Firewall

The License Server installer checks for the Windows Firewall and adds the necessary rules if it is
present. If you use another firewall software, or a physical firewall between the server and the
client computers, the following ports must be opened:

® TCP Port 16720
® UDP Port 16720

27.5 Stand-alone Licenses

The Stand-alone licenses tie a given software application to a single machine. This method of
licensing requires a machine's unique identifier (SID) to be incorporated in the license activation
process. After buying the product, a generic license is sent to you. This license must be installed
and activated before you can use the software. In the activation process the license is linked to
the hardware.

License Installation

As soon as your order is authorized, we will send to you an e-mail with the license code and links
to download the software. On this page, we explain how to install and activate a Stand-alone
license.

To install a Stand-alone license, you must:

1. Obtain the License Code from the registration e-mail.
2. Install the license during the software installation, or later using the License Manager tool.

3. Activate your license.

Installation of the Stand-alone license
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In the e-mail sent after purchasing the product you will find the license code, in the form of a
block of letters and numbers. When you are asked for this code, copy and paste it in the window.
Please make sure that you do not include any other text besides the code itself:

= Mew license

Paste your
license code
here

[ Ok ] [ Cancel

If the entered code is valid, press Ok. The license is installed on your computer and you can
continue with the installation process. You can also review and activate the license later, using
the License Manager tool.

License Activation

When a new license is installed, you're asked to activate it. In this process the license is linked to
your hardware. You can choose two different methods:

Online activation

If you have an Internet connection, you can activate your software online. The License Manager
will connect with our activation server through a secure connection, and the activation codes are
sent and installed in one step.
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3. Obtain keys

M arme | Your company name

4, Finizh

Product |Licensed Product

5/M | 0000000000

Click to get

I Proceed

activation

Connecting...
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1. Select "Activate Online" as the activation method.

2. Check that the license data is correct and press "Proceed" to start the activation process.

3. The software connects to our Activation Server through a secure connection (no personal

information is sent during the process). After few seconds your license will be activated,

and your software will be ready to use.

Manual activation

If you have trouble with the on-line activation, or the computer where your are using the license

does not have Internet access, you can use Manual activation.

1. Select "Activate Manually" as the activation method.

2. Open a link to our Activation Web page and enter the codes given by the dialog.

3. Following the steps indicated in the page, you'll be given an Activation Code, enter this

code in the dialog box when requested to activate your license.

In either case, if you have trouble during the activation, you may contact us at activate@

itoosoft.com.

License Manager

When you install any Itoo Software commercial product, the installer also includes the Itoo

Software License Manager. This tool is used to manage the licenses of your purchased software.
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To open the License Manager, select "License Manager" in the "ltoo Software" group of the Start
menu. The are four tabs in this tool, two of them are only visible if your computer acts as a
license server (not applied for Stand-alone method, see Floating/Network licenses):

When opened, the License Manager displays the installed licenses. You can retrieve license
details, check its status, add new licenses or activate them as show below:

License Panel

Licenses can be in different states, depending of the type of license and its activation status:

e & Activated Stand-alone licenses: Shown in black text, these licenses are ready to be
used.

* . Un activated licenses: Red text with a warning icon, these licenses are valid but have
not yet been activated. You must activate them before using.
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® 5( Broken licenses: Red text with an error icon . These licenses have corrupted data and
can't be used in any form. You must reinstall them.

For more information about a license, you can click on the "Details..." button, where you can see
the data stored in the license.

Installation of new licenses

If you have not installed a license with the software installation process, use the "Add.." button in
the licenses tab. The installation process is the same as the one described above for the installer.

Activation of the selected License

When a new license is installed, you're asked to activate it. In this process the license is linked to
your hardware. The activation process is the same as the one described above for the installer.
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